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CHAPTER 1:  
INTRODUCTION 

 

This research project was conducted in two phases. Phase one of this project explored the 

potential for beneficial use of simulation, optimization, and decision analysis tools to assist the 

Texas Department of Transportation (TxDOT) in optimizing strategies for acquiring right-of-

way parcels, particularly strategies regarding the timing of parcel purchasing. The findings of 

phase one are reported in Technical Report 0-5534-1, “Asset Management Literature Review and 

Potential Applications of Simulation, Optimization, and Decision Analysis Techniques for Right 

of Way and Transportation Planning and Programming.” A recommendation from phase one was 

to select a single business science tool as the core approach to decision support, and that the 

other methods may be incorporated where they offer the greatest benefit as feasible within the 

limitations of this research project. Consequent meetings with the TxDOT project monitoring 

committee resulted in the selection of simulation as the most suitable business science tool for 

evaluating right-of-way acquisition timing options. The tool development plan included use of 

optimization to provide early acquisition budget recommendations to users. 

ORGANIZATION OF THE REPORT 

This report includes the results of phase two of this research project, including gathering 

necessary historical right-of-way acquisition information, analysis of this information, and the 

development of decision-support tools to assist TxDOT in obtaining cost savings through 

improved timing of right-of-way parcel acquisitions. 

The report is composed of eight chapters. This chapter provides an introduction to phase 

two of this research project. It describes project objectives, the nature of the research problem, 

and describes the organization of this report. 

Chapter 2 describes the processes of gathering historical right-of-way information, the 

analysis of this information, and the application of this information in creating a simulation 

model named TAMSIM. 

Chapter 3 presents TAMSIM, the simulation-based right-of-way acquisition decision-

support tool developed during phase two of this project. TAMSIM methodology, required inputs, 
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and tool outputs are described to assist new users of this tool in determining most likely total 

right-of-way costs to be anticipated should various purchasing strategies be selected. 

Chapter 4 describes sensitivity testing performed by the research team to explore 

TAMSIM functionality characteristics.  

Chapter 5 presents the optimization-based right-of-way acquisition decision-support tool 

named EROW. The EROW dynamic programming approach, required inputs, and tool outputs 

are described to assist new users of this tool in determining optimal budgeting for early right-of-

way acquisitioning. 

Chapter 6 describes the research team’s analysis of TxDOT’s fleet management and 

vehicle replacement methodologies and resulting recommendations for potentially enhancing this 

area of TxDOT asset management using business science tools.  

Chapter 7 includes the implementation plan for moving the developed right-of-way 

decision-support tools into routine use within TxDOT. 

Chapter 8 summarizes the conclusions and recommendations resulting from phase two of 

this project. 

The tools developed during phase two of this project, TAMSIM and EROW, are included 

on a CD-ROM in a jacket inside the cover of this report. 

TXDOT CHALLENGES IN RIGHT-OF-WAY ACQUISITION 

The process of acquiring necessary right of way for a highway construction project can 

considerably impact the project’s completion time and total cost. The degree of impact to these 

important considerations fluctuates based upon a number of variables associated with project and 

parcel characteristics. One of the ways to reduce potential negative impact from the right-of-way 

acquisition portion of the project is to acquire portions of the right of way earlier than the 

conventional process. TxDOT currently has limited authority to acquire right of way prior to 

completion and approval of required environmental studies, which is the conventional time for 

the Right of Way Division (ROW Division) to issue a right-of-way release to the district office to 

begin purchase negotiations. The stipulations for beginning the purchasing process in advance of 

that time are that landowner hardship is involved, the property is to be donated, or when property 

improvements are imminent. The latter category of advance acquisition is termed a protective 
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buy and is generally restricted to situations where improvements are not only planned, but 

construction is thought to possibly begin in the near future.  

In addition to challenges associated with limited ability to pursue purchasing early in the 

project planning process, another challenge to TxDOT is determining the budget amount that 

should be allocated to acquiring parcels early. TxDOT has limited experience with these early 

purchases, and determining when the rate of return from early right-of-way purchases exceeds 

rates of return for other uses of budget resources is formidable. 

Experience has shown that waiting until normally required steps in project planning have 

been completed before acquiring certain right-of-way parcels can result in substantially increased 

purchase costs for the State of Texas. Landowners have in the past improved properties within 

the projected facility footprint during the transportation facility planning process. In some cases 

this has been done with apparent full knowledge that a State of Texas purchase would occur in 

the future. Even when physical improvements are not made, landowners may continue to plan 

new “best uses” of their property, which can then result in huge increases in purchase costs. A 

fairly common situation found by TxDOT ROW procurement personnel is that an investor or 

investment group has purchased property within the projected footprint and has proceeded to 

plan a new housing or commercial development, again, very likely with full knowledge that the 

State of Texas will be purchasing the property for transportation improvements. Investors well-

understand that current interpretation of state law requires the State to purchase the property 

considering this new best use probability.  

However, before seeking expanded legislative authority for acquiring right of way at 

earlier times in the project planning process, it is necessary to have a mature understanding of the 

potential impact that expanding early acquisition may have on project costs. The complexity of 

the issues and variability in situations surrounding acquisition of right-of-way parcels has made 

quantification of these impacts, particularly on a statewide basis, extremely difficult if not 

impossible. 

PROJECT OBJECTIVE 

The objective of this project was narrowed by the sponsor to focus on creating decision-

support tools to assist TxDOT in optimizing right-of-way acquisition strategies, particularly 

regarding the timing of acquisitions in locations where land speculation activities as well as 
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actual or planned property improvements may substantially increase right-of-way costs to the 

State of Texas. Two decision-support tools were designed and developed to meet this objective. 

A simulation tool was designed to model project right-of-way related costs and milestone 

time durations during the Plan Authority and Develop Authority planning phases, both with and 

without early right-of-way acquisition occurring. These costs include not only the purchase of 

the right of way itself, but also cost estimates associated with the possible delay in construction 

start time due to lack of right of way.  

The second decision-support tool is an optimization process for estimating the rate of 

return appropriate to anticipate from incremental increases in the budget amount made available 

for early right-of-way acquisition. The results from the optimization tool are valuable during the 

budget planning process. The tool compares anticipated rates of returns from acquiring right of 

way early to a rate of return expected from other potential uses of the evaluated budgetary 

amount, as entered by the user. Results are numerically and graphically displayed.  

EARLY ACQUISITION DEFINITION 

Early acquisition of right of way as this expression is used in this report is defined to be 

the purchase of parcels that is initiated during the time span between the availability of the 

design schematics and the completion and approval of the environmental study resulting in 

conventional right-of-way release from the ROW Division. This approximates the defined time 

period for “advance” acquisition to occur as referenced in TxDOT right-of-way related manuals. 
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CHAPTER 2:  
RIGHT-OF-WAY ACQUISITION DATA GATHERING AND ANALYSIS 

 
Development of a simulation tool requires determination of data attributes for the 

variables included in the process being simulated. Acquisition costs and time durations are the 

key variables involved with right-of-way acquisition simulation and were therefore the focus of 

research team data analyses. The Right of Way Information System (ROWIS) database was the 

primary source of right-of-way acquisition data to be analyzed. Interviews with key TxDOT 

personnel involved in right-of-way acquisition practices were also conducted to complement the 

information obtained from ROWIS. Results from the data analyses are the basis for the 

TAMSIM decision-support tool. This chapter describes the data gathering, presents the analyses 

conducted, and introduces the application of statistical data to TAMSIM. 

 

RIGHT-OF-WAY ACQUISITION DATA GATHERING 

Historical Data from TxDOT’s Right-of-Way Information System  

ROWIS is a relational database and data management program used by the ROW 

Division and district offices (Gibson et al. 2005). ROWIS captures key attributes of the property 

acquisition process. These key attributes can largely be categorized into four groups: 

 project level attributes: district, county, highway, control-section-job (CSJ) number, 

parcel number, etc.; 

 parcel level attributes: property type, taken area, remainder area, type of damages, type 

of improvements, type of acquisition, etc.; 

 time attributes: environmental clearance date, right-of-way release date, appraisal report 

date, value approved date, possession date, etc.; and 

 cost attributes: land value, damage value, improvement value, total appraised value, total 

approved value, total acquisition cost, etc. 

ROWIS data received from TxDOT consisted of a number of tables retrieved from the 

relational database according to the different attribute levels of the contained records. The 

different levels of records in the raw data tables include the project level, parcel level, 

component level, as well as others. The simulation model is focused on parcel level activities, 

which are later summed for a project level analysis. Since the simulation model was to be built 
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on these analyzed historical records, it was crucial that well-representative data sets be selected 

from the raw data provided by TxDOT.  In order to better reflect recent trends occurring in the 

ever-changing right-of-way acquisition realm, older records, those with parcel possession dates 

prior to year 2003, were filtered out and not included in research team analyses. Records were 

carefully checked to avoid input errors and data inconsistency, i.e., typographical errors, 

violations of precedence relationship between important dates, etc. All cost terms were adjusted 

by the appropriate House Price Index (HPI) factor to take into account the inflation rates 

affecting property costs (OFHEO 2008).  A more detailed description of the filtering process is 

provided in the following section. 

With the close collaboration of the TxDOT Right of Way Division a total of four sets of 

ROWIS data were received during the course of this project, as shown in Table 1. The fourth 

data set, which is the most comprehensive and updated set, provided the statistical data attributes 

for the simulation model described in Chapter 3. 
 

Table 1. ROWIS Data Sets Received from TxDOT. 
 

 
1st ROWIS  

Data Set 
April 2007 

2nd ROWIS  
Data Set 
July 2007 

3rd ROWIS  
Data Set 

November 2007 

4th ROWIS  
Data Set 

April 2008 

Geographical 
Location 

5 counties from  
1 district  
(SAT) 

67 counties from  
9 districts  
(ABL, AUS, BRY, 
CRP, ELP, FTW, 
HOU, WAC, WFS) 

18 counties from  
3 districts  
(FTW, HOU, 
SAT) 

141 counties 
from all 25 
districts 

Time Period (a) 1985 – 2007 1985 – 2007 2003 – 2007 
2003 – April 

2008 
Number of 
Projects (b) 

27 323 128 579 

Number of 
Parcels (b) 

296 5,313 2,127 7,559 

 (a) Based on parcel possession dates 
 (b) The project and parcel numbers are those from the combined tables after the data filtering process 

 Data Filtering and Aggregating 

 The fourth ROWIS data set was received from TxDOT in the form of five different tables 

in order to minimize data redundancy and to keep related attributes within the same table.  

However, the tables of data could not be used without checking data integrity. ROWIS data 

records are placed in the database by authorized district personnel as activities and events occur 
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on right-of-way related projects. Even though ROWIS is carefully designed to ensure the quality 

of data being entered through numerous pull-down menus and check boxes (TxDOT 2006), a 

degree of human error is virtually unavoidable in complex right-of-way projects lasting over a 

number of years. Common errors include data omission, typographical errors, and precedence 

violation between entered dates. The data filtering process utilized included the following steps: 

• Delete records with the following blank date fields: 

o blank Environmental Clearance Date, 

o blank Right of Way Release Date, 

o blank Appraisal Report Date, 

o blank Value Approved Date, and 

o blank Possession Date. 

• Delete records with old date values: 

o records with parcel possession dates before year 2003, and 

o records with erroneously old dates for environmental clearance, ROW release, 

appraisal report, and value approved (for example, a record with environmental 

clearance year of 1900). 

• Delete records with no Acquisition Type Code. 

• Delete records with the following precedence violations: 

o Right of Way Release Date is earlier than Environmental Clearance Date. 

o Appraisal Report Date is earlier than Right of Way Release Date. 

o Value Approved Date is earlier than Appraisal Report Date. 

o Possession Date is earlier than Value Approved Date. 

• Delete records without cost values.  

The data filtering process above removed approximately 37 percent of the records 

provided to the research team. Remaining data was then processed further to standardize land 

area units, sum multiple payments on individual parcels, and multiply cost values by appropriate 

Texas HPI factors to standardize property dollar values. Texas HPI factors used are those 

published by the Federal Housing Finance Agency (FHFA).  

 After filtering, the remaining records in the five tables were combined for further 

analysis. The combining process was performed within the MS Access® database due to the 

complex relationship between the tables. Figure 1 represents the multiple one-to-many 
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relationships between the tables. For example, one record from the Possessed Parcels table may 

correspond to multiple records from the Parcel Payments table and the Parcel Appraisals table.  

The Possessed Parcels table acted as the center of the merges during the combining process 

because the focus of this study primarily involves parcel level aggregation.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Milestone Dates of Right-of-Way Parcel Acquisition Activities 

 Project development is a time-consuming process that varies typically from 3 to 10 years.  

During this process environmental clearance and right-of-way acquisition take up a significant 

portion of the total time before construction begins. The right-of-way acquisition process 

1. Possessed Parcels 

2. Parcel Payments 

3. Parcel Components 

4. Parcel Appraisals 

5. Advanced Acquisitions 

Filtered and Combined Table (38 Fields and 7,559 Records) 

many one 

many 

one 

many one 

one one 

ERROR CHECKING, FILTERING, AND 
COMBINING PROCESS

Figure 1. Relationship Diagram between ROWIS Tables. 
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typically begins with right-of-way release after environmental clearance is obtained. Right-of-

way release is followed by appraisal, negotiation, possession, and relocation. Milestone dates 

through the right-of-way acquisition conventional process are summarized in Figure 2 (Gibson et 

al. 2005). 

 In Figure 2, the duration from environmental clearance to right-of-way release, D1, is 

common to all parcels of a project. However, the durations from right-of-way release to 

possession, D2, usually varies among individual parcels. Hence, the parcel environmental 

clearance to possession time duration of interest at the project level is the time duration required 

to acquire the last parcel.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

Definitions of the milestone dates shown in Figure 2 are as follows: 

 Environmental Clearance Date: During the plan authority phase an environmental 

assessment is performed for approval by the Environmental Affairs Division (ENV 

C D E F G A B 

Duration from Environmental Clearance to Possession 

D1: Duration from 
Env. Clearance to 
ROW Release 

D2: Duration from ROW Release to Possession 

D3 D4 D5 D0: Duration 
from end of 
a feasibility 
study to 
Environment
al Clearance 

Figure 2. Milestone Dates and Durations for the Right-of-Way Acquisition Process. 
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Division). The environmental clearance date is the date when the ENV Division approves 

the environmental study. Typically, the right-of-way acquisition process can not start 

until the environmental clearance is approved and right-of-way release has been granted.  
 

 Guess Estimate Date: A rough estimate of necessary parcel acquisition cost is needed at 

an early stage of the project development process, well before the right-of-way 

acquisition process is approved to begin. District right-of-way section personnel prepare 

these estimates based on various factors such as historical purchase records of parcels 

with similar characteristics, current market values, and expert knowledge about the 

acquisition process. According to the historical data gathered from the San Antonio 

District right-of-way office, these “guess estimates” are usually conducted after 

environmental clearance and before the release of the right of way for acquisition. Due to 

considerable inaccuracies associated with guess estimates, which often are required 

within several days of the request, and other complicating factors, this cost and its date 

are not included in current simulation modeling. 
 

 Right of Way Release Date: After environmental clearance, the district office requests an 

authorization from the ROW Division to start the right-of-way acquisition process. The 

right-of-way release date is the date that the ROW Division advises the district that they 

have the approval and authority to begin the right-of-way acquisition process (TxDOT 

2006). Typically, the right-of-way acquisition process can not start until the right-of-way 

release for the project is received by the district from the ROW Division.  Any parcel 

acquisition made before conventional right-of-way release is referred to as an advance 

acquisition in TxDOT’s right-of-way related manuals. Under current legislative 

authority, advance acquisition is possible only for hardship acquisitions, protective 

buying, and donations (TxDOT 2006). 

 
 Appraisal Report Date: After receiving right-of-way release from the ROW Division, the 

district often assigns an independent contract appraiser to determine the current value of 

the parcels required by the construction project. Each parcel’s appraised value is then 

submitted to the district right-of-way section on Form ROW-A-10, Tabulation of Values, 

which includes land value, improvements value, and cost of damages (TxDOT 2006). 
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 Value Approved Date: Before initiation of landowner negotiations, the appraised value is 

reviewed by the district right-of-way section and the ROW Division. The Value 

Approved Date is the date at which the ROW Division advises that the value placed on 

the parcel, including all improvements to the parcel, is acceptable (TxDOT 2006).  

 
 Possession Date: After the appraised value is approved, a parcel goes into the negotiation 

process. Depending on the result of negotiations with the property owner, the parcel 

acquisition process follows one of two tracks to completion, a negotiated settlement or 

condemnation proceedings. The Possession of Parcel date is defined for negotiated 

parcels as the date of completion of ROW-N-72, Title Company’s Closing Statement, and 

is defined for condemned parcels as the date of deposit shown on ROW-E-ND, Notice of 

Deposit (TxDOT 2006). 

 
 Let Date: The let date is the estimated date on which the project will be placed in a letting 

for receiving contractor bids to provide the construction. This date is not considered in 

the current simulation program because the goal of this study is limited to estimating 

right-of-way costs and the time at which the right-of-way acquisition process will be 

completed (TxDOT 2003). 

Interviews of Experienced Right-of-Way Section Personnel 
Selected TxDOT personnel with experience in right-of-way acquisition were interviewed 

to better understand the reasons why districts prefer in some cases early acquisition instead of the 

conventional acquisition process.  

Frances Willison, Director Right of Way, Houston District; Scott B. Hall, District Right 

of Way Administrator, Fort Worth District; Denise Baxter, Right of Way Agent, Fort Worth 

District; Randall Redmond, Director of Transportation Planning and Development, Tyler 

District; and Thomas L. Doss, Right of Way Administrator, Tyler District, were interviewed 

from the districts. The research team also met with Donald Toner, Jr., Keith Sliger, and Kerry 

Fulton of the Texas Turnpike Authority (TTA) division. All of these right-of-way professionals 

provided valuable information about TxDOT processes, methods, and situations in which right-

of-way costs can escalate rapidly. 
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District right-of-way section personnel reported they mainly have used the protective buy 

and hardship provisions of currently available early acquisition processes when advance or early 

acquisition was to be pursued. One district also mentioned donations still occurring occasionally. 

All interviewed individuals described parcels where considerable amounts of State of Texas 

funding either were saved or could have been saved if early acquisition could or would have 

been used to avoid cost escalation. Some examples follow: 

 A parcel cost estimate was $0.5 million as pasture land in 2001. This property was 

purchased for $3.3 million in 2004 as residential property. The district estimated that the 

cost could have gone up to $6 million if purchasing had been delayed further. 

 A parcel cost increased from $0.17/sq ft up to $0.23/sq ft in 3 years.  

 A parcel cost for pasture land went from $7,000 per acre to $22,000 per acre in 3 years.  

 Total parcel costs for a group of parcels went from an estimated $5.4 million to 

$10 million when not acquired early. 

 Total parcel costs for a group of parcels went from an estimated $5 million to 

$15 million.  

Speculator activity was mentioned as being a significant factor in right-of-way cost 

increases, particularly in metropolitan and urban areas. In short-term speculation, it was reported 

that properties can change ownership many times in a short period of time, with each sale at an 

increased price. Oftentimes short-term speculators become active when they believe that the 

State has begun right-of-way purchasing for a transportation project. 

Some speculator activity has the appearance of having the sole purpose of creating 

increased purchase costs to the State of Texas. One example is subdividing larger land tracts to 

create multiple purchases by the State at the higher cost per unit area normally involved with 

smaller parcel purchases. Another example is preparing drawings and plans for new home 

subdivisions even though it was common public knowledge and almost certainly known by the 

landowners that the land for the new subdivision was to be purchased by the State for 

transportation-related construction. Property owners have also been observed to subdivide 

properties in a manner that causes remaining land areas to become landlocked after the State 

purchases necessary rights of way, thereby causing damage costs to be incurred by the State of 

Texas for those properties outside of the immediate areas being purchased.   
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In the opinion of experienced right-of-way TxDOT personnel, acquiring certain parcels 

of property at an earlier date than would occur under standard acquisition methods has the 

potential of avoiding some of the property cost escalations being experienced. The following set 

of recommendations represents a general consensus of thought for applying asset management 

principles to right-of-way early acquisition: 

 Projects should be evaluated on a case-by-case basis to determine if early acquisition of 

certain parcels would be beneficial. 

• Protective buying can reduce costs to the State of Texas if: (a) parcels are located in an 

area where cost can increase rapidly, (b) a significant percentage of the total number of 

parcels will be purchased early, and (c) parcels are acquired early enough to avoid 

speculation and/or improvements being added to the properties. 

• Speculation, improvements to the property, and damages to the remainder of the property 

are considered to be the major factors causing significantly increased land costs during 

the TxDOT project planning process. 

• Good communication with cities and counties will help identify areas where cost can 

increase significantly from initial estimates. This knowledge can position the district 

office to take action to minimize the impact of potential cost escalation. 

• Parcels should be purchased when they are vacant whenever possible. Waiting to 

purchase vacant property allows the opportunity for improvements to be planned or even 

constructed. 

ANALYSIS OF HISTORICAL RIGHT-OF-WAY ACQUISITION DATA 
 The analysis of ROWIS data was centered on parcel acquisition time duration and total 

parcel cost as these are critical elements of the TAMSIM model. The analysis was conducted 

using different grouping schemes for the right-of-way acquisition information being analyzed. 

The objective of the analyses was to identify common characteristics for each group of parcels 

and projects. The four grouping schemes for the data analyses were: 

 acquisition type: negotiation (NE) versus eminent domain (ED), 

 county type by population: metropolitan, urban, and rural, 

 acquisition method: in-house versus outsourced procurement, and 

 acquisition timing: early acquisition versus conventional acquisition. 
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 Researchers analyzed a total of 7,559 parcel acquisition records dating from September 

2002 through April 2008. For each grouping scheme, data sets were filtered to include only 

complete parcel information sets. Incomplete records were not included in the analysis. As a 

result, the actual number of parcels used in the analysis varies for each grouping scheme. The 

data used in these analyses are provided in Appendix A on the CD-ROM found inside the 

cover of this report. 

Data Analysis by Acquisition Type 

 Even though there are a number of types of acquisitions recorded in ROWIS, most of the 

acquisitions fall into one of the following two general categories: Negotiation and Eminent 

Domain.  Administrative settlement was a third category considered separately in the earlier 

research report from this project. However, in a broad sense, an administrative settlement is 

regarded as a type of possession by negotiation. Hence, it is categorized and analyzed as a type 

of negotiation in the current analysis. 

 Table 2 compares time durations experienced during negotiation and eminent domain 

acquisitions. As mentioned above, administrative settlement cases are included in the negotiation 

category. Parcels acquired by eminent domain take the longest average durations, 59 months 

from environmental clearance to possession and 39 months from right-of-way release to 

possession. Notice that the median values are smaller than corresponding average values for both 

negotiation and eminent domain parcel acquisitions. Also notice that the median and average 

durations are in relatively close proximity compared to the maximum durations experienced. 

These data characteristics suggest that the average values are affected heavily by a relatively 

small number of difficult cases requiring very long time durations. 
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Table 2. Time Durations by Acquisition Type (a). 
 

Acquisition 
Type 

Number 
of 

Parcels 

Time Duration from Environmental 
Clearance to Possession (months) 

Time Duration from ROW Release to 
Possession (months) 

Median Ma x. Average Std. 
Dev. Median Ma x. Average Std. 

Dev. 

Negotiation 6,705 29.2 391.5 37.4 32.9 15.6 252.2 20.5 20.0 

Eminent 
Domain 

825 45.1 247.6 59.4 44.2 29.6 235.3 38.7 31.5 

All Parcel 
Acquisitions 

7,530 31.0 391.5 39.8 35.0 16.8 252.2 22.5 22.3 

(a) From 4th ROWIS data set received in April 2008 

 Table 3 shows cost data for negotiation and eminent domain parcel acquisitions. In this 

table, the eminent domain land cost average is $6.66/sq ft, which is twice as much as the 

negotiated land cost average of $3.29/sq ft. The cost difference between the two acquisition types 

is larger when total acquisition costs are considered. Average total acquisition cost under 

eminent domain is more than three times larger compared to negotiation acquisition. Notice that 

in both cases median values for acquisition costs are much smaller than average values. These 

results imply that the distributions are skewed positive with elongated tails to the right. 

Table 3. Costs by Acquisition Type (a). 
 

Acquisition 
Type 

Number 
of 

Parcels 

Land Cost  
($/sq ft) 

Total Acquisition Cost  
($, thousands) 

Median Ma x. Average Std. 
Dev. Median Ma x. Average Std. 

Dev. 

Negotiation 6,705 0.38 96.14 3.29 6.92 14.7 20,095 105.7 552.2 

Eminent 
Domain 

825 1.83 69.14 6.66 9.80 56.9 11,417 350.3 965.7 

All Parcel 
Acquisitions 

7,530 0.45 96.14 3.66 7.36 16.8 20,095 132.5 616.0 

(a) From 4th ROWIS data set received in April 2008 

Data Analysis by County Type (Population) 

 The ROWIS data set received in April 2008 contains parcel acquisition records occurring 

in 141 of the 254 counties in Texas. These 141 counties are distributed across the state and 
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represent a large variety of socioeconomic characteristics. Counties with populations of 400,000 

or above are classified as metropolitan counties, those with populations between 50,000 and 

400,000 are classified as urban counties, and those with populations below 50,000 are classified 

as rural counties.  

Table 4 shows the analysis of data with the records grouped by county type. There are 

nine counties having populations greater than 400,000. Among them, Harris County is the largest 

and includes the City of Houston. There are also 37 urban counties and 95 rural counties.    

   
Table 4. Categorization by County Type (Population). 

 

  
Table 5 shows time durations by county type. The average time duration between 

environmental clearance and parcel possession is the longest for metropolitan counties 

(52 months) followed by urban counties (38 months) and rural counties (30 months). The time 

durations between right-of-way release and parcel possession follow the same pattern. 

County Type 

Number of 
Counties with 

Parcel 
Acquisitions in 

ROWIS 

Number of 
Parcel 

Acquisitions 
in ROWIS 

County Name Total Population 
(Census 2000) 

Metropolitan 
(pop. > 400K) 

9 2,191 

Harris 3,400,578 

Dallas 2,218,899 

Tarrant 1,446,219 

Bexar 1,392,931 

Travis 812,280 

El Paso 679,622 

Hidalgo 569,463 

Collin 491,675 

Denton 432,976 

Urban 
(50K < pop. < 400K) 

37 2,423 

Fort Bend 354,452 

Cameron 335,227 

… … 

Rural 
(pop. < 50K) 

95 2,475 

Wise 48,793 

Lamar 48,499 

… … 

Submittal



 

17 
 

Metropolitan counties averaged approximately 31 months, urban counties averaged about 

21 months, and rural counties only 17 months.  

 
Table 5. Time Durations by County Type (Population) (a). 

  

County Type 
Number 

of 
Parcels 

Time Duration from 
Environmental 

Clearance to 
Possession (months) 

Time Duration from 
ROW Release to 

Possession (months) 

Average Std. Dev. Average Std. Dev. 
Metropolitan  
(pop. > 400K) 

2,191 52 41 31 33 

Urban                        
(50K < pop. < 400K) 2,423 38 34 21 16 

Rural  
(pop. < 50K) 

2,475 30 26 17 11 

All County Types 7,089 40 35 23 22 

 (a) From 4th ROWIS data set received in April 2008 

   

Table 6 shows parcel costs by county type. Each cost value occurring before 2007 was 

adjusted to current value in 2007 using House Price Indices. Metropolitan counties have the 

highest average cost at about $9/sq ft, and rural counties have the lowest average cost of about 

$0.64/sq ft.  

As observed for land costs per square foot, metropolitan counties show the highest 

average total acquisition costs (over $274,000). When these values are compared with those from 

rural counties, the average total acquisition cost for a parcel in a metropolitan county is about 

nine times the average total acquisition cost for a parcel in a rural county. Overall, the ratios 

between metropolitan and rural counties in Table 6 are much larger than the ratios in Table 5, 

meaning that cost variables are more sensitive than time durations between socio-geographic 

areas. 
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Number of Counties Using Outsourced 
Parcel Acquisition 

68  
(48%) 

60 
(43%) 

13 (9%) 

Outsourcing Only In-House 
Only 

Mixed-Use 

Number of Parcels Acquired through 
Outsourcing Versus In-House 

4,414 
(58%) 

3,116 
(42%) 

Outsourced 
Parcels 

In-House 
Parcels 

Table 6. Costs by County Type (Population)(a) . 
 

County Type 
Number 

of 
Parcels 

Land Cost  
($/sq ft) 

Total Acquisition Cost 
($, thousands) 

Average Std. Dev. Average Std. Dev. 

Metropolitan  
(pop. > 400K) 

2,191 9.04 10.74 274.3 1,044.9 

Urban                        
(50K < pop. < 400K) 2,423 2.53 4.41 105.6 294.1 

Rural  
(pop. < 50K) 

2,475 0.64 2.29 32.0 87.5 

All County Types 7,089 3.88 7.53 132.5 616.0 

 (a) From 4th ROWIS data set received in April 2008 

Data Analysis by Acquisition Method 

 Since 2003, TxDOT has adopted outsourcing as an alternative method to using in-house 

capabilities to acquire parcels. Figure 3 shows outsourcing use for parcel acquisition by TxDOT 

districts. Outsourcing was used to acquire 4,414 parcels, or 58 percent of the total number of 

parcels. As shown in pie chart (A), more than half of the districts are using outsourcing. Pie chart 

(B) shows the number of parcels by agent type.   
 

       (A) Number of Counties Using Outsourcing                   (B) Number of Parcels by Agent Type 
 

Figure 3. Use of Outsourcing for Parcel Acquisition. 
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Table 7 shows average durations and average total costs dependent upon if the parcel 

acquisition was outsourced or performed with in-house capabilities. As shown in the table, the 

average duration and cost of parcels acquired using outsourcing were slightly lower than the 

averages of those parcels acquired in-house. There is also a significantly lower standard 

deviation in parcel acquisition durations when acquisitioning was outsourced. This difference 

may be due, in part, to the practice of districts taking back responsibility for acquisition when an 

outsource acquisition effort goes to eminent domain proceedings.   

 
Table 7. Outsourcing: Cost and Duration (a). 

 

Acquisition Method 
Number 

of  
Parcels 

Duration from ROW 
Release to Possession 

(months)  

Total Acquisition Cost 
($, thousands) 

Average Std. Dev. Average Std. Dev. 

In-House 3,116 25 29 136.5 676.1 

Outsourced 4,414 21 15 129.7 569.7 

All Acquisition 
Methods 

7,530 23 22 132.5 616.0 

     (a) From 4th ROWIS data set received in April 2008 

Data Analysis by Acquisition Timing 

 Records of parcels acquired through early acquisition were identified in the data set. Only 

66 parcels from the entire data set, less than 1 percent, were acquired through early acquisition. 

Table 8 compares costs and time durations for parcels acquired through early acquisition to 

parcels obtained through conventional acquisition. A significant reduction of time duration is 

observed from right-of-way release to possession when early acquisition is pursued, 22 months 

for conventional acquisition to 11 months for early acquisition. However, the total average 

acquisition cost is higher for parcels acquired through early acquisition ($468,828) than the 

average cost of parcels acquired through conventional acquisition ($132,864). The apparent 

reason for this average cost difference is that the majority of parcels acquired through early 

acquisition are located in metropolitan counties where land values are usually much higher even 

though parcel sizes tend to be smaller.  
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Table 8. Comparison of Early and Conventional Acquisition Costs and Durations (a). 
 
 

Acquisition 
Timing 

Number 
of  

Parcels 

Duration from ROW 
Release to Possession 

(months) 

Total Acquisition Cost 
($, thousands) 

Average Std. Dev. Average Std. Dev. 

Early Acquisitions 66 11 15 468.8 1,161.2 

Conventional 
Acquisitions 

7,121 22 22 132.9 617.5 

All Acquisitions 7,187 22 21 136.0 625.3 

    (a) From 4th ROWIS data set received in April 2008 

 
 Table 9 shows time durations and costs of parcels by type of early acquisition and 

whether the purchase was made through negotiation or eminent domain proceedings. The 

average time duration for early acquisition through negotiation was 9 months for hardship cases 

and 10 months for protective buy cases, while time durations for early acquisition through 

eminent domain proceedings were 26 months for hardship cases and 15 months for protective 

buy cases. As was shown in Table 2, through a conventional acquisition process, acquiring a 

parcel takes an average of about 21 months from right-of-way release to possession through 

negotiation and an average of about 39 months for parcels acquired by eminent domain 

proceedings.  

 Regarding costs, the average total acquisition cost when a parcel was acquired through 

negotiation under hardship provisions was $187,038, and it is $772,997 for parcels acquired 

through eminent domain proceedings. Also, the total acquisition costs for parcels acquired 

through protective buy by negotiation averaged $375,409, and averaged $3,395,691 for parcels 

acquired through protective buy through eminent domain proceedings. Limited conclusions can 

immediately be drawn from this difference. It is likely that properties having higher value will 

more frequently be taken to eminent domain proceedings by the landowners.  
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Table 9. Early Acquisition by Acquisition Type (a). 
 

Type of Early 
Acquisition 

Acquisition 
Type 

Number 
of 

Parcels 

Average Time 
Duration from 

ROW Release to 
Possession (months) 

Average Total 
Acquisition Cost 

($, thousands) 

Hardship 
Negotiation 12 9 187.0 

Eminent 
Domain 

6 26 773.0 

All Hardship Acquisitions 18 15 382.4 

Protective Buy 
Negotiation 46 10 375.4 

Eminent 
Domain 

2 15 3,395.7 

All Protective Buy Acquisitions 48 10 501.3 

All Early Acquisitions 66 11 468.8 

  (a) From 4th ROWIS data set received in April 2008 

 

Most of the parcels purchased through early acquisition are located in metropolitan areas. 

The number of records for parcels acquired through early acquisition (66 records) is too small for 

comparing statistics with the conventional acquisition process (7,121 records). Lack of early 

acquisition records placed increased importance on research team interviews of TxDOT 

personnel with experience in early acquisition.  

Relationship Analysis of Parcel Costs and Time Durations 

 Average acquisition costs and average time durations are plotted to observe if there is any 

relationship or trend between these two variables. Figure 4 shows land costs versus time 

duration. Most of the time durations are scattered, around 10 to 20 months, regardless of the land 

costs.  Figure 5 shows total parcel costs versus time durations. Most of the data are within the 

region of less-than-50-month duration and less than $60,000 for the total cost. Data are scattered, 

and no correlation is observed from these plots. 
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Figure 4. Land Cost vs. Time Duration Scatter Graph - Negotiated Parcels. 
 

 

Figure 5. Total Parcel Cost vs. Time Duration Scatter Graph - Negotiated Parcels. 
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 Table 10 displays results of a statistical analysis evaluating potential correlation between 

negotiated time durations and parcel costs. Correlation coefficients were calculated. The 

correlation coefficient between right-of-way release to possession time duration and the land cost 

is 0.012, while the correlation coefficient between this same time duration and the total parcel 

cost is 0.061. These are very small values, which confirm what was observed from the plotted 

data in Figures 4 and 5. No correlation exists between these two variables. When there is a 

perfect positive relationship between two variables, the correlation coefficient becomes 1. The 

coefficient reduces to zero when there is no correlation whatsoever between the variables. 
 

Table 10. Correlation Coefficients between Negotiated Parcel Costs and Durations. 
 

 Land Cost  
($/sq ft) 

Total Parcel Cost 
($, thousands) 

Duration from Right-of-
Way Release to Possession 

(months)  

Land Cost ($/sq ft) 1 0.265 0.012 

Total Parcel Cost ($, thousands) 0.265 1 0.061 

Duration from Right-of-Way 
Release to Possession (months) 0.012 0.061 1 

APPLICATION OF STATISTICAL DATA TO TAMSIM  

TAMSIM Model Basis 

A simulation model requires statistical information for variable data to be processed 

during its use. Appropriate statistics derived from the latest and largest ROWIS data set were 

incorporated into TAMSIM during the tool development process. As stated earlier, the volume of 

data pertinent to early parcel acquisitions was minimal, allowing what is believed to be an 

adequate but not particularly strong set of statistical criteria for the development of TAMSIM. 

As TxDOT’s experience with early parcel acquisitions increases, it will be possible to refine 

TAMSIM with stronger statistical criteria for early parcel acquisitioning.  

Time durations and parcel costs during the right-of-way acquisition process are the major 

data inputs for TAMSIM. These inputs are described in the following sections. Chapter 3 

provides a comprehensive discussion of TAMSIM. 
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Time Durations 

 Time durations were analyzed to become the underlying input to the simulation model for 

estimating parcel acquisition times and costs. There are three major time durations used in the 

simulation program. Reference to Figure 2 is helpful in describing the time durations included in 

TAMSIM. The first duration is the time between completion of the feasibility study and when 

environmental clearance is obtained (D0). The second duration is the time between 

environmental clearance and when right-of-way release (D1) is obtained from the ROW 

Division. The last time duration is from right-of-way release until parcel possession (D2). 

ROWIS does not currently incorporate the initial date attribute necessary to calculate the 

duration until environmental clearance (D0). Therefore, TAMSIM receives this duration 

information by direct entry of the user on the Basic Data screen. The duration from the end of the 

feasibility study to environmental clearance (D0) and the duration from environmental clearance 

to right-of-way release (D1) are considered project level durations because they do not depend 

upon events at the individual parcel level.  Hence D0 and D1 apply to all of the individual 

parcels in the same project. In contrast, durations D3, D4, and D5 shown in Figure 2 are parcel-

specific time durations.  

Costs Terms 

 A number of different cost values are stored in the ROWIS database to document parcel 

acquisition activity. Among them, Land Cost per Square Foot, Total Approved Value, and Total 

Acquisition Cost were selected for analysis and inclusion in the TAMSIM model. In the cost 

tables, Total Approved Value represents the amount of money approved by the ROW Division 

after the district submits Form A-10 that includes the appraised values of the land, 

improvements, and damages. Total Acquisition Cost represents the sum of all entered “Payment 

Amount” values until a parcel is acquired. It includes the actual expenses under the “ROW 

Acquisition Expenses” item of Expense Category, e.g., court cost, appraisal cost, title company 

work, etc. Since there are several payment categories for a parcel, all payments for each parcel 

are summed to obtain the total cost. Total Acquisition Cost is the final representative cost term in 

the right-of-way process selected for analysis. The current version of TAMSIM estimates Total 

Acquisition Cost as the output of simulation runs. 
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CHAPTER 3:  
TAMSIM: A SIMULATION PROGRAM FOR RIGHT-OF-WAY 

ACQUISITION  

APPLICATIONS FOR TAMSIM 
 TAMSIM is envisioned to have two primary applications: as a policy tool at the state 

level and as a decision-support project tool at the district level. When used as a policy tool, a 

generic project can be simulated to determine the effect that various proposed policies regarding 

early acquisition of right of way may have on statewide right-of-way costs. At the district level, 

TAMSIM can be used by right-of-way section managers to determine the likely effects on a 

specific project if some of its parcels are acquired early. Due to the nature of TAMSIM input and 

the fact that in some sense each project is unique, the value and dependability of TAMSIM 

output are directly related to the user’s depth of right-of-way acquisition experience and 

familiarity with the local right-of-way market.  

TAMSIM OVERVIEW 
 TAMSIM is a simulation program designed to provide statistical measures of the impact 

that right-of-way acquisition timing can have on a project’s costs and completion date. As a 

simulation model, it takes into account inherent variabilities that are part of the right-of-way 

acquisition process. These variabilities include the possibility of condemnation proceedings 

becoming required, the length of time for negotiations to be completed, and the costs involved in 

taking possession of parcels. The tool recognizes that natural variation occurs in time durations 

involved in the process, occasionally requiring an unusually long period of time to complete, in 

which case there could be added costs due to a late start on construction. Conversely, there is the 

possibility that the acquisition process could take an unusually short period of time, in which 

case there could be cost benefits associated with an early start on construction. The potential for 

possible cost increases or for cost savings are included in the model. TAMSIM includes 

sequential time durations between events in the project development and right-of-way 

purchasing processes. All time duration measures within TAMSIM are relative to time zero, 

which is defined as the point in time at which the initial roadway schematics become available. 

 There are four major phases in the development process of a TxDOT construction 

project:  Feasibility Study, Plan Authority, Develop Authority, and Construct Authority. During 

the Plan Authority phase of a project, an initial set of schematics is created to indicate parcels of 
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land necessary to acquire for the project. In some cases alternative roadway alignments are 

considered at this early point in planning, each with differing right-of-way acquisition needs. 

TAMSIM analysis allows the consideration of multiple roadway alignments.  

The purpose of the simulation model is to provide mean and standard deviation estimates 

for right-of-way costs and time durations at the project level. The simulation tool is designed for 

primary use by TxDOT districts toward the beginning of the Plan Authority phase, as the 

schematics are being developed. TAMSIM estimates total project right-of-way costs incurred 

throughout the Plan Authority and Develop Authority phases of the project and estimates the 

time at which all right-of-way acquisition will be finalized so that the Construct Authority phase 

can begin. 

TAMSIM DATA INPUT 
As was described in Chapter 2, attributes of data from ROWIS and hard files were 

determined for use in developing the TAMSIM model. Due to the effort and time required to 

extract data from hard files, most of the data analysis efforts involved ROWIS data. Figure 6 is a 

simplified version of Figure 2 showing important dates and durations available in ROWIS. The 

time related data needed for the simulation are the durations from environmental clearance to 

right-of-way release and the durations from right-of-way release to possessions of parcels.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

C D E F GA B

Duration from Environmental Clearance to Possession 

Duration from 
Env. Clearance 
to ROW Release Duration from ROW Release to Possession

Figure 6. Dates and Time Durations for the Simulation Model. 
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Upon opening TAMSIM, the initial screen (Figure 7) offers the user a choice of 

continuing an earlier project analysis or beginning analysis of a new project. If the new project 

option is selected, the next screen to appear is the Parcel Generator screen (Figure 8).  

 

 

Figure 7. TAMSIM Initial Screen. 
 

 

Figure 8. TAMSIM Screen for Parcel Generation. 
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The purpose of the Parcel Generator screen is to allow the user to describe the set of 

parcels for the project that is to be simulated. There are five key characteristics of the parcel set 

for the user to select. The first is the location of the project. The user is provided a drop-down 

menu from which to select the best descriptor of the project location. The remaining four 

characteristics to be entered by the user are 1) the total number of parcels involved on the 

project, 2) the number of these parcels likely to receive improvements in the opinion of the user, 

3) the number of parcels to purchase early in the simulation to be performed, and 4) the number 

of different roadway alignments to be considered in the analysis. 

The number of parcels likely to receive improvements or to see abnormally large cost 

increases due to speculator activity during the Plan Authority or Develop Authority phases of 

project development is a critical input, which should be determined by the most experienced 

right-of-way personnel available to the district. These data are critical because early acquisition 

for these parcels is most likely to be economically worthwhile; thus, normally the number of 

parcels to purchase early will be less than or equal to the number of parcels in which future 

improvements are likely.   

The simulation to be performed will generate costs and time durations based on data 

attributes determined from the analyses of ROWIS data described in Chapter 2. These data 

attributes were determined for groups of data. When the user selects the project location 

descriptor from the drop-down menu on the Parcel Generator screen, this selection causes the 

simulation to run using data variability attributes found in parcel data sets from similar locations. 

TAMSIM also places default data in data entry fields based on historical data from these similar 

locations. Virtually all project and parcel data values and information initially displayed by 

TAMSIM can be changed by the user. Modification of the TAMSIM default information to 

better reflect the specific project and individual parcels will enhance accuracy and value of 

TAMSIM output. The data attributes for a Generic County in Texas were derived from all 

analyzed parcel acquisition data. The data attributes for a Metropolitan area were obtained from 

analyzing parcel acquisition information from all counties with populations larger than 400,000. 

The Urban area attributes are from counties with a population between 50,000 and 400,000, and 

the Rural area attributes are from those counties with a population less than 50,000 population. 

Adequate data was available to individually include Dallas, Harris, and Tarrant Counties as 

location options having specific data attributes for simulation. 
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Within a specific project, the duration of time that it takes to acquire a parcel is not 

independent of the duration of time to acquire another parcel within the same project. The same 

is true of the cost to purchase a parcel; therefore, the mean and standard deviation for both 

duration and costs were obtained by analyzing parcels within specific projects. In order to have 

meaningful data, it was decided to only include data from projects with a minimum number of 

parcels. For determining generic county project data attributes, only projects with at least 25 

parcels were considered. For determining data attributes for metropolitan, urban, or rural areas, 

researchers considered only projects with at least 20 parcels.  For individual counties, it was 

decided that if a county had at least five projects containing 10 or more parcels, then such a 

county would be included as an option in the drop-down menu to supply unique data attributes 

for the simulation tool. Dallas, Harris, and Tarrant were the only counties with this level of 

parcel acquisition data available.  

An alignment refers to a collection of parcels that will be accepted or rejected as a unit 

during the environmental clearance process. Because TAMSIM is designed to be used before the 

environmental clearance has been obtained, there is a possibility that some of the parcels listed in 

various alignments will not be necessary for the final approved corridor.   

The Alignment screen (see Figure 9) is used to identify the multiple alignments when 

appropriate. When more than one alignment is specified on the Parcel Generator screen, the 

Alignment screen will appear for the user. If only one alignment is considered, then all parcels 

listed will be included in the final approved corridor, and the tool by-passes the Alignment 

screen. Alignments are organized into groups such that one, and only one, alignment from each 

group will be accepted for the final approved corridor. Alignments within one group must always 

be listed consecutively on the Alignments screen with the first alignment of each group being 

identified by a check box. Since only one alignment from each group will be selected for 

inclusion in the final approved corridor, the sum of likelihoods associated with the alignments 

within one group must equal 1.0. The data fields on the Alignment screen shown in Figure 9 are 

as follows: 

1. Alignment Description (Num and ID). The first two fields represent descriptive data for 

the alignment. The first field is automatically filled, and the number assigned to the 

alignment cannot be modified. The second field is available so that alignments can be 

named by the user to facilitate later identification.   
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2. Start New Group. Alignments form groups so that one and only one alignment within a 

group will be selected for a project. Alignments associated with one group must be listed 

together, and the first alignment that begins a new group must be indicated with a check 

mark in this column. 

 

 

Figure 9. TAMSIM Screen for Optional Alignments. 
 

3. Likelihood of Inclusion. The simulation model is designed to be run toward the end of the 

Feasibility phase or the Plan Authority phase of a project, before it is known with 

certainty what the final approved corridor will be; thus, it is possible that an alignment 

(i.e., a set of parcels) identified during the Feasibility phase as possibly being within the 

required corridor may not end up within the final corridor as approved during 

environmental clearance. If it is known with certainty that an alignment will be included 

in the final approved corridor, then 1.0 should be entered for the “Likelihood of 

Inclusion”; otherwise, a value less than 1.0 should be entered. If 0 is entered, then that 

alignment will never be included within the final plan during simulation, which is 

equivalent to deleting that alignment (and any associated parcels) from the project. 

4. Permit Cost. If there is a permit cost and/or other unique cost associated with an 

individual alignment, it is entered in the final column of data. 
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There are three categories of input data in addition to the alignment information: project 

level data, parcel specific data, and possession time/cost data. Project level data (see Figure 10) 

include such factors as inflation rate, target date for the beginning of the Construct Authority 

phase of the project, penalty costs for not starting the Construct Authority phase by the target 

date, cost benefits if the Construct Authority phase starts early, estimates for the length of time 

from the end of the Feasibility phase until environmental clearance is obtained, estimates for the 

length of time from obtaining environmental clearance until right-of-way release is obtained, the 

rate of property cost increase (in addition to standard inflation) resulting from TxDOT planning 

activity, the event that causes the additional cost increase to begin, and an offset applied to the 

event causing the additional cost increase.  

 

Figure 10. TAMSIM Screen for Project Level Data. 
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 The final three data inputs (namely, the additional property cost increase, the event 

causing the additional increase to begin, and the time offset) refer to cost increases in property 

values that are in addition to normal inflation (but not caused by additional improvements to the 

property). Based on several interviews of experienced TxDOT ROW acquisition personnel, it 

appears the most common reason attributed to additional cost increases is the purchase of land by 

speculators. It is not always clear when speculative activity begins during the project planning 

process. The triggers appear to vary in different metropolitan and urban areas. Therefore, 

TAMSIM allows the user to indicate the time anticipated for additional parcel cost increases to 

begin occurring. This time is defined by entries in the “Speculation begins” and “Offset for 

Speculation” data entry fields. For example, assume that for a particular project the analyst feels 

that speculation will likely begin two months after the right-of-way release is obtained, then the 

option “ROW Release Obtained” would be selected using the drop-down menu for “Speculation 

begins,” and “2 months” would be chosen using the drop-down menu for “Offset for 

Speculation.” The offset can be any number of months between plus 24 months and minus 

24 months. 

Parcel level data are those data that depend only on parcel type (Figure 11). Several of 

the data items depend on probabilistic events, and when generating these random events, parcels 

are considered independently.  

A short description of each data type included for parcel-level information follows: 

 

1. Parcel Number and Identification: The parcel number cannot be changed, but the ID can 

be changed to be more descriptive for a specific parcel. 

2. Associated Alignment: The simulation model is designed to be run toward the end of the 

Feasibility phase or the Plan Authority phase of a project, before it is known with 

certainty what the final approved corridor will be; thus, it is possible that parcels 

identified during the feasibility phase as possibly being within the required corridor may 

not end up within the final corridor as approved during environmental clearance. Parcels 

that are accepted or rejected as a unit are associated with an alignment and such an 

alignment is identified in the third column. The probability that an alignment will be 

included in the final approval is given on the Alignments screen. If all parcels identified 

in the project are to be included in the final corridor, then only one alignment will be 
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used, and the Alignment screen never appears. In this case, all parcels are associated with 

alignment 1 on the Parcel Data screen.  

 

 

Figure 11. TAMSIM Screen for Parcel Level Data. 
 
 

3. Likelihood of Outsourcing: A number between zero and one is entered representing the 

probability that the parcel will be obtained through the use of non-TxDOT personnel. 

Outsourcing may make a difference with respect to the time duration of taking possession 

of the parcel although the analysis performed indicates that the cost of the parcel seems to 

be independent of outsourcing.  Enter 1 in this column if it is known with certainty that 

the parcel will be acquired through an outside contractor. Enter 0 if it is known with 

certainty that acquisition will be obtained by in-house personnel.   

4. Likelihood of Condemnation: A number between 0 and 1 is entered representing the 

probability that the parcel will be obtained through condemnation proceedings. If a parcel 

is obtained through condemnation, the probability distribution laws related to both the 

cost of the parcel and the time duration to take possession are affected. Enter 1 if it is 
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known with certainty that this parcel will go through condemnation proceedings and 0 if, 

in the opinion of the analyst, there is no chance that it will go through condemnation. 

5. Likelihood of Improvements Beginning after the Feasibility Study Phase of the Project: A 

number between 0 and 1 represents the probability that improvements will be made to the 

parcel. The usual reason for considering early acquisition is that parcel improvements are 

being considered. If no improvements are expected, then this probability would be set to 

0 and early acquisition would be unlikely. When this entry is 0, the remaining entries for 

that parcel are ignored. However, if improvements are a possibility, then a positive value 

would be entered here, and it is important to fill in the remaining data entries. 

6. Time Duration over which Improvement Will Likely Occur: The next four entries refer to 

establishing a probability law that will reflect the timing over which the improvements 

will be made.   

7. Cost Multiplier for Improvements: During the simulation, a random value based on a 

probability law defined through the next screen will be generated that will represent the 

cost of each parcel. If improvements are made on the parcel, then this random value will 

be multiplied by the value (any number greater than one) entered here to determine the 

total cost of the parcel. 

8. Early Acquisition Indicator:  If there is a check mark under this entry, then the parcel will 

be acquired early during the simulation to be performed. The total project right-of-way 

costs and the time at which all parcels are purchased will be computed without early 

acquisition unless this box is checked for a parcel. 

  

The Parcel Possession/Cost Data screen (see Figure 12) includes the data that define the 

various probability distributions used to generate the length of time that it takes to purchase a 

given parcel and the final cost of the parcel. Within a specific project, the duration of time that it 

takes to acquire a parcel is not independent of the duration of time to acquire another parcel 

within the same project. Because of this dependency, the mean duration for acquiring parcels of 

a project is first generated. The data associated with the mean over all parcels within a project is 

on the first line of the Parcel Possession/Cost Data screen (this line is number zero.) All other 

lines on this screen refer to individual parcels. Thus, if information is known about a specific 

parcel, data for that parcel can be changed, and it will be handled separately. If data on line zero 

is changed, all parcels are affected.   
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Figure 12. TAMSIM Screen for Possession Time and Cost Data. 
 

All probability distributions for the duration of time to acquire a parcel and its cost are 

based on the lognormal distribution. The lognormal distribution was chosen based on a curve 

fitting several data sets of parcel costs and durations. It is also a logical distribution to use 

because its skewed nature implies that unusually long times or unusually large costs should be 

expected. Because a lognormal distribution is skewed and thus its characteristics are sometimes 

non-intuitive, additional information about the distribution is displayed on the screen. At the start 

of each replication, a mean value for the duration of time needed to acquire a parcel will be 

generated as well as the mean cost for the parcel. These means are displayed on the first line 

(line number 0) on the Parcel Possession/Cost Data screen. The duration of time, T, needed to 

acquire a specific parcel is determined according to the following: 
  

T  =  es                                                                                                                 3-1  

where S has a normal distribution with 
 

EሾSሿ  = β0 + β1 ln൫τproj൯  + β21{condemn} + β31{outsource}     and     varሺSሻ = σ1
2 

  

where proj is the mean duration of parcel acquisition times for the project, 1{condemn} equals 1 if 

the parcel is condemned and zero otherwise, and 1{outsource} equals 1 if the parcel is outsourced 

and zero otherwise. The values for the constants 0, 1, 2, 3, and 1 are fixed in the Access data 

base and cannot be changed through program control. The parcel cost is similar. First the mean 

value for cost of all parcels within the project, proj, will be generated based on the data in the 
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first row (line number 0) of the Parcel Possession/Cost Data screen. Then the cost of the 

individual parcel, X, will be generated as follows: 

 

X  =  eY                                                                                                            3-2 

where Y has a normal distribution with 

 

EሾYሿ  =  β4 + β5 ln൫Xproj൯  + β61{condemn}          and         varሺYሻ  =  α0 + α1Xproj 

  

where proj is the mean cost of parcels for the project, 1{condemn} equals 1 if the parcel is 

condemned and zero otherwise. The values for the constants 0, 1, 4, 5, and 6 are fixed in the 

Access data base and cannot be changed through program control.  Notice that the variance of 

the cost for parcels depends on the mean cost. The value for 1 is positive; thus, a project that 

has a large average cost per parcel will also have a large variance of parcel costs.  The following 

table gives the values of these constants as currently used in TAMSIM. 

Table 11. Table of TAMSIM Data Values. 
 

Parameter Generic Metro Urban Rur al Dallas Harris Tarrant 
Likelihood of 
Outsourcing 0.7298 0.7384 0.6901 0.7052 0.5848 0.6679 0.8143 
Project Level 

Inflation 0.2 0.4 0.15 0 0.4 0.4 0.4 
Likelihood of 

Condemnation 0.1003 0.1879 0.0888 0.0863 0.1579 0.3547 0.0286 
Number Parcels 49 42 42 43 28 24 40 
Mean (duration) 2.907 3.306 2.877 2.734 3.116 3.342 2.796 
Stdev (duration) 0.530 0.614 0.487 0.384 0.318 0.209 0.362 
0 (duration) -0.0349 -0.0828 -0.0979 -0.0936 -0.1673 -0.0348 -0.2815 
1 (duration) 0.9846 0.9975 1.0043 0.9344 1.0273 0.9900 1.0640 
2 (duration) 0.4063 0.2545 0.3952 0.5076 0.4900 0.1643 0.0001 
3 (duration) -0.0145 0.0014 -0.0017 -0.0014 -0.1109 -0.0323 0.0863 
 (duration) 0.2924 0.2792 0.2976 0.2933 0.3271 0.2413 0.2483 
Mean (cost) 3.942 5.439 3.953 3.032 5.303 6.231 4.086 
Stdev (cost) 1.368 1.46 1.121 0.851 1.171 1.271 2.081 
4 (cost) -0.2845 -0.1019 -0.2873 -0.2529 -0.2554 -0.6203 -0.2786 
5 (cost) 0.8486 0.7997 0.8583 0.8345 0.8093 0.8540 0.8907 
6 (cost) 0.5431 0.6116 06252 0.3833 0.6173 0.6591 0.9035 

 All areas:  0 = 0.6514
 All areas:  1 = 0.1653 

TAMSIM METHODOLOGY 

The simulation program essentially performs a statistical experiment. As with any 

experiment, several data points are needed in order to obtain good estimators. When TAMSIM is 
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initially opened, the user has the option of entering and/or changing any data and then executing 

the simulation. The simulation develops multiple data points, with each data point being a single 

realization of the project.  

The number of realizations, or replications, of the project to be developed during the 

simulation run is selected by the user on the Basic Data screen. Each replication involves 

generating parcel purchase times according to various probability distributions as defined by the 

data input screens for the time of environmental clearance, the time of right-of-way release, and 

the times of possession for each parcel. Parcel purchase costs are also generated according to 

probability distributions for acquisition of each parcel. Each replication will produce different 

times and costs due to the random probabilistic nature of a simulation.  

Each realization of the project is generated on a parcel by parcel basis. Cost and time 

duration values are generated for each parcel based upon appropriate data attributes for parcels 

from the selected project location. TAMSIM repeats this process for all parcels, and the total 

acquisition cost for right of way is determined by summing all parcel costs. The time when 

construction may begin is determined by the time when the last parcel was acquired during the 

project realization. The generated total parcel acquisition cost and time duration to completion of 

purchasing each represent one data point. TAMSIM generates project realizations, each with 

associated data points generated, until the number of replications specified by the user on the 

Basic Data screen is reached. All data points are then statistically analyzed, and TAMSIM 

displays estimates for mean, median, and standard deviation for total parcel costs and time 

durations to complete parcel purchasing. After each replication, the total project cost and 

duration are determined both with and without early acquisition so that a comparison is possible 

using the same realizations for both situations.    

The difference in cost with and without early acquisition will be affected by two factors:  

1) the cost of improvement made to the property after the Feasibility Study phase and 2) the 

additional increase in property value that often occurs once TxDOT begins purchasing parcels.  

When the cost of a parcel is generated according to Eq. (3-2), it represents total parcel costs 

except that costs of improvements occurring after the Feasibility Study phase are not included. 

Separate values are generated representing the cost of improvements made during the Plan 

Authority and Develop Authority phases and representing the duration over which these 

improvements will occur. Values for these variables are generated according to the data on the 
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Parcel Level Data screen (Figure 11), the final cost of improvements being assumed linear 

during the improvement time. For example, consider a specific parcel for which data were 

entered indicating that the improvements would start at time 0 (i.e., as soon as the initial 

schematics are available), and the time duration over which the improvement occurs would be 

between 5 and 15 months, with the most likely occurrence being 8 months. Furthermore, suppose 

that these improvements are expected to double the price of the parcel (i.e., an improvement 

multiplier of 2 was used). Now for a particular project realization, if the time duration for these 

improvements to occur was randomly generated to be 10 months, and the time duration 

generated to purchase the parcel early was 5 months, the final cost of the parcel would be 

150 percent of the cost of the parcel as generated from Eq. (3-2). Under the “no early acquisition 

scenario,” the final cost of the parcel would be 200 percent of the cost generated from Eq. (3-2), 

assuming that the Environmental Clearance plus right-of-way release were longer than 

10 months. 

The cost increase rate due to TxDOT activities (generally attributed to speculators) is a 

location-specific value needed for the simulation program that could not be obtained directly 

from ROWIS data, since the ROWIS cost data would already include such a cost increase. The 

user inputs this cost increase rate on the Basic Data screen (Figure 10) based on local experience 

with speculator activity. TAMSIM begins applying this rate of cost increase at the time defined 

by the user on that same screen. To illustrate how this cost increase is used within the 

calculations, assume that t0 denotes the time of the event that begins property costs increases (for 

instance, at right-of-way release), and let r be the rate increase in the cost. Now consider a parcel 

that was purchased at time t1 and, if early acquisition could be used, would be purchased at time 

t2. Finally, assume that c0 is the unobserved cost of the parcel at time t0, c1 is the observed cost of 

the parcel at time t1, and c2 is the estimated cost of early acquisition at time t2. In this case, the 

cost of the parcel when it is purchased without early acquisition would be 
 

c1  =  c0 ×  expሼrሺt1-t0ሻሽ                                                                                          3-3 

Continuous compounding is assumed, and the normal inflation rate is ignored since a present  
 
value based on the normal inflation rate will be calculated. The difficulty is that the data give 
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estimates for c1 and not c0; therefore, the generation of costs will produce a value for the final 

purchase cost only; namely, c1.  For comparison purposes, the cost at early acquisition, or at time 

t2, needs to be estimated. Using Eq. (3-3) to solve for c0, the following equations are obtained: 
  

c2  =  c1 ×  expሼ-rሺt1-t0ሻሽ          for t2< t0                 and                                       3-4 

c2  =  c1 ×  expሼ-rሺt1-t2ሻሽ          for t2< t0         
 

Thus, the cost of the parcel at the time of early acquisition depends on the generated variable cost 

value of the parcel at its final time of purchase. 

TAMSIM OUTPUT 
Each replication of the project creates a realization of time duration and total cost to 

acquire each parcel. After the run of all project replications is complete, the Summary Statistics 

screen (Figure 13) appears showing the anticipated effect of the early acquisition scenario that 

was analyzed. The summary includes mean values, standard deviation, and the 10, 50, and 

90 percentile values for both total parcel costs and time duration to complete purchasing 

activities. If the cost differences shown under the “Impact of Early Acquisition” portion of the 

screen are negative, early acquisition is projected to have reduced costs. 

 

Figure 13. TAMSIM Screen for the Summary of Results. 
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The user may view all results from the simulation that has been run on the Detailed 

Results screen (Figure 14).  This screen can be accessed only after the simulation has been 

executed. Immediately under the title of this screen is a drop-down menu that allows the choice 

of project replication number. By changing the replication number, the user may observe results 

from any individual project realization. 

The costs and time durations both with and without early acquisition are displayed for 

each project realization. The difference in cost with and without early acquisition is due to the 

additional increase in property value due to speculative activities plus the improvements made to 

the parcel during the Plan Authority phase of the project. It is interesting to note that speculative-

related cost increases in property values often begin with the first TxDOT purchase of a parcel. It 

is, therefore, possible that the early acquisition of relatively few parcels on a project could in 

some cases increase the total cost of a project because of an earlier start of speculative activity 

on parcels not purchased early.   
 

 

Figure 14. TAMSIM Screen for Detailed Results. 
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There are three types of data displayed on the Detailed Results screen for each parcel. 

These are: 

 

1. Parcel Description (Number, Name). The first two fields represent descriptive data for 

the task or parcel. Asterisks before the name of a parcel indicate that the parcel was 

purchased through eminent domain for that replication. The number in parentheses 

indicates the alignment that contains the parcel.   

2. Duration (Duration, End). The first row in the grid always refers to the time for obtaining 

the environmental clearance, and the second row refers to the time for obtaining the 

release to begin the right-of-way acquisition process. Each row after that until the final 

row refers to the task of obtaining possession of a specific parcel. Time duration values 

are always measured in terms of the number of months after the design schematics have 

become available. The value for the ending time in the final (or “Stop”) row of the grid is 

the maximum ending parcel possession time. There are two ending times presented, 

1) the time required to purchase the property if no early acquisitions are made and 2) the 

time required under the early acquisition simulation. If a parcel is purchased through 

early acquisition, the value will be red.  If the task durations are blank, then the alignment 

associated with the parcel as specified on the Parcel Data screen was not included in the 

final approved corridor. 

3. Costs (Present Value Cost, Present Value Cost with Early Acquisition). The final two 

columns refer to the predicted cost of the parcel with and without early acquisition. Red 

numbers indicate that these parcels were purchased early. These costs are always in terms 

of present value, i.e., costs in terms of dollars at time 0 (namely, when the design 

schematics become available). The cost of improvements made on the parcel after time 0 

is based on data entered on the Parcel Data screen. Cost is based on the probability that 

an improvement will actually occur as well as the timing and amount of improvement 

that occurred. Since it is assumed that the parcel acquisition costs are always entered by 

the user in terms of present-day dollars, normal inflation will not affect costs. Any 

appreciation in property value that is above the inflation costs will, however, cause an 

increase in present-day dollar cost of the parcel depending on the time at which the 

appreciation starts as specified on the Basic Data screen. If a parcel is purchased through 

early acquisition, the value will be red. If the task durations are blank, then the alignment 
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associated with the parcel as specified on the Parcel Data screen was not included in the 

final approved corridor. 

 

In addition to the parcel related data, the cost increase due to late completion of 

purchasing or a cost savings due to early completion is also given. These costs are also 

determined based on the cost data entered by the user on the Basic Data screen.  

TAMSIM creates two text files to allow communication of simulation results to EROW, 

the optimization program described in Chapter 5 for assisting budget planners in determining 

optimal budget amounts for early right-of-way acquisition. The first file created is called 

Cost.out and contains the average value over all replications of the amount of purchase cost spent 

for early acquisitions. The second file created is called Save.out and contains the average amount 

of reduction in total right-of-way costs due to early acquisitions; thus, a negative number in the 

Save.out file refers to an increase in average total cost. Each run of TAMSIM will produce one 

number to each file as a separate row. If no files with these names are in the folder containing 

TAMSIM.exe, they will be created automatically by TAMSIM when the user elects to save a 

simulation run.  

TAMSIM HELP INFORMATION 

TAMSIM includes comprehensive Help information to assist tool users. This information 

can be accessed at any time via the Help tab at the top of the screen or by hitting the F1 key. 

Information contained in the TAMSIM Help section is included as Appendix B.  

POSSIBLE TAMSIM ENHANCEMENT 

There are currently no costs or disadvantages within the TAMSIM model associated with 

early parcel acquisition. Thus, TAMSIM always views early acquisition of a parcel as 

advantageous. A potential enhancement to TAMSIM was identified as this project was 

concluded. It appears possible to establish within TAMSIM a discriminating factor associated 

with the public benefit of a completed project should early acquisition funding have been used in 

that manner instead of for early right-of-way acquisition. This factor would serve as a cost 

consideration when early acquisition occurs within the simulation process. Then, an optimization 

procedure could be developed so that TAMSIM would not only yield total acquisition costs but 
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would also produce a recommendation for which specific parcels should be purchased early. 

EROW, the optimization program described in Chapter 4, will provide similar recommendations 

for selecting projects most suited for early acquisition, which are system-level recommendations. 

Project-level recommendations for individual parcels to be acquired early are not provided at this 

time.    
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CHAPTER 4:  
TAMSIM SENSITIVITY ANALYSIS 

 
A TAMSIM sensitivity analysis was conducted with hypothetical project information. 

The six hypothetical projects used current TAMSIM default data entries, except as modified for 

analysis, for projects identified as being located in Metro, Urban, Rural, Dallas, Harris, and 

Tarrant Counties. Table 12 shows the default values for each hypothetical project. The sensitivity 

analysis consisted in running simulations to estimate costs and savings for each project under the 

following five speculation-begin scenarios:  

1. Environmental Clearance Obtained, 

2. First Parcel Purchased (not early), 

3. Schematics Available (time 0), 

4. First Parcel Purchased (early), and 

5. ROW Release Obtained. 

For each speculation-begin scenario the number of parcels acquired early was varied 

from 1 to the total number of parcels.  
 

Table 12. Sensitivity Project Characteristics. 
 

Project 
Name 

 
 

Total 
Number 

of 
Parcels 

 

Number of 
Parcels for 

Possible 
Improvement 

 

Cost 
Multiplier 

for 
Improvement

 

Additional 
Cost 

Increase 
Due to 

Speculation 
(%/yr) 

Likelihood 
of 

Outsourcing 
 

Likelihood of 
Condemnation

 

Metro 42 7 5 40 0.7384 0.1879 
Urban 42 5 4 15 0.6901 0.0888 
Rural 43 2 3 10 0.7052 0.0863 
Dallas 28 5 5 40 0.5848 0.1579 
Harris 24 5 6 40 0.6679 0.3547 
Tarrant 40 6 5 40 0.8143 0.0286 

 

COSTS AND SAVINGS ANALYSIS 
 

Costs and savings without and with early acquisition were obtained from the sensitivity 

analysis. TAMSIM was run for each speculation-begin scenario varying the number of parcels 

acquired early. Therefore, TAMSIM was run 42 times for the Metro project, 42 times for the 
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Urban project, 43 times for the Rural project, 28 times for the Dallas project, 24 times for the 

Harris project, and 40 times for the Tarrant project, under each of the five speculation-begin 

scenarios. Data used in a project was the same for the five speculation-begin scenarios. 

As an example, Table 13 shows costs and savings for the Metro project for the 

“environmental clearance obtained” speculation-begin scenario. A description of the parameters 

shown in this table follows: 
 

 Case Number: From1 through 42, and is the same as the number of parcels to be acquired 

early. 

 Project Total Cost without Early Acquisition: This is the project cost if no parcels are 

acquired early. 

 Project Total Cost with Early Acquisition: This is the project costs with the specified 

number of parcels acquired early. It is calculated by subtracting the value of expected 

savings from early acquisition from project total costs without early acquisition. 

 Present Value with Early Acquisition: This value is the individual present value of a 

parcel if acquired early. 

 Total Cost of Parcels Acquired Early: This is the cumulative value of parcel present 

values with early acquisition.  

 Expected Savings from Early Acquisition: This is the anticipated amount of savings to be 

obtained from parcels acquired early.  
 

Costs and savings results from sensitivity testing were graphed to better display results. 

These show cost savings due to early acquisitions, total project costs with early acquisitions, total 

project costs without early acquisition, and total costs of parcels acquired early. Results for the 

each speculation-begin scenario for the Metro project are included and discussed herein.   
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Table 13. Costs and Savings for the Metro Project under the “Environmental Clearance 
Obtained” Speculation-Begin Scenario. 

 

Case # 
 
 

Project Total 
Cost without 

Early 
Acquisition 

($1,000s) 

Project Total 
Cost with 

Early 
Acquisition 

($1,000s) 

Present 
Value with 

Early 
Acquisition 

($1,000s) 

Total Cost 
of Parcels 
Acquired  

Early 
($1,000s) 

Expected 
Savings 

from Early 
Acquisition

($1,000s) 

0 $147,320 $147,320  $0  $0 $0 
1 $147,320 $96,939  $1,614  $1,614 $50,381 
2 $147,320 $83,713  $318  $1,932 $63,607 
3 $147,320 $77,887  $200  $2,132 $69,433 
4 $147,320 $56,335  $627  $2,759 $90,985 
5 $147,320 $41,896  $413  $3,172 $105,424 
6 $147,320 $35,298  $165  $3,337 $112,022 
7 $147,320 $23,578  $401  $3,738 $123,742 
8 $147,320 $23,263  $120  $3,859 $124,057 
9 $147,320 $22,972  $107  $3,966 $124,348 

10 $147,320 $22,733  $106  $4,072 $124,587 
11 $147,320 $22,393  $156  $4,228 $124,927 
12 $147,320 $22,104  $173  $4,401 $125,216 
13 $147,320 $21,591  $83  $4,484 $125,729 
14 $147,320 $21,385  $76  $4,561 $125,935 
15 $147,320 $20,602  $371  $4,932 $126,718 
16 $147,320 $20,323  $118  $5,050 $126,997 
17 $147,320 $19,970  $229  $5,279 $127,350 
18 $147,320 $19,792  $60  $5,339 $127,528 
19 $147,320 $19,479  $101  $5,440 $127,841 
20 $147,320 $19,256  $71  $5,511 $128,064 
21 $147,320 $18,776  $168  $5,679 $128,544 
22 $147,320 $18,018  $267  $5,945 $129,302 
23 $147,320 $17,601  $137  $6,082 $129,719 
24 $147,320 $17,020  $184  $6,266 $130,300 
25 $147,320 $16,732  $247  $6,513 $130,588 
26 $147,320 $16,567  $106  $6,619 $130,753 
27 $147,320 $16,239  $105  $6,724 $131,081 
28 $147,320 $15,574  $477  $7,201 $131,746 
29 $147,320 $15,385  $82  $7,282 $131,935 
30 $147,320 $15,071  $83  $7,366 $132,249 
31 $147,320 $14,823  $116  $7,481 $132,497 
32 $147,320 $14,351  $225  $7,707 $132,969 
33 $147,320 $13,735  $166  $7,873 $133,585 
34 $147,320 $13,506  $84  $7,957 $133,814 
35 $147,320 $12,626  $378  $8,335 $134,694 
36 $147,320 $12,477  $48  $8,383 $134,843 
37 $147,320 $12,205  $124  $8,507 $135,115 
38 $147,320 $11,753  $134  $8,640 $135,567 
39 $147,320 $11,142  $167  $8,807 $136,178 
40 $147,320 $10,912  $129  $8,936 $136,408 
41 $147,320 $9,963  $578  $9,515 $137,357 
42 $147,320 $9,591  $115  $9,630 $137,729 
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 “Environmental Clearance Obtained” Speculation-Begin Scenario 

Figure 15 displays the costs and savings for the Metro project under the “environmental 

clearance obtained” speculation-begin scenario. The slope of the savings is positive throughout 

the graph; that is, savings continue to increase as the number of parcels obtained by early 

acquisition increases. The savings start at $50,381,000, if obtaining only parcel 1 by early 

acquisition in case 1. The maximum savings that can be obtained is $137,729,000, when all 42 

parcels are obtained by early acquisition in case 42. By analyzing the slope of the line for the 

total project cost with early acquisition, it can be observed that there is a significance difference 

in the total costs between case 3 and case 4. This is due to the $21,552,000 increase in savings 

when parcel 4 is acquired early in case 4. The slope for savings from early acquisition rapidly 

increases from case 1 through case 7. For case 7, the savings from early acquisition reaches 

$123,742,000. Purchases of additional parcels early thereafter increase savings at a much slower 

rate. The lines for the total project cost with early acquisition and for cost of early acquisition 

almost meet in case 42 at $9,629,000 with a difference of $38,000. 

 

 

Figure 15. Metro Project Costs and Savings under the “Environmental Clearance 
Obtained” Scenario. 
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“First Parcel Purchased (Not Early)” Speculation-Begin Scenario 

When the first parcel is purchased by early acquisition in the Metro project under the 

“first parcel purchased (not early)” speculation-begin scenario, the savings from early acquisition 

are $48,452,000. The savings from early acquisition again increase rapidly from case 1 to case 7, 

when the savings reach a value of $119,597,000. After case 7, the savings from early acquisition 

followed a constant slope. When all 42 parcels are obtained by early acquisition, the cost with 

early acquisition is $20,027,000, while the total project cost without early acquisitions remains 

on $147,320,000.  The maximum savings from early acquisition when all 42 parcels are acquired 

early is $127,293,000. Figure 16 shows these estimates. 

 

 

Figure 16. Metro Project Costs and Savings under the “First Parcel Purchased (not early)” 
Scenario. 
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$147,320,000, and the maximum savings from early acquisitions when all 42 parcels are 

acquired early is $140,237,000. On the other hand, if just one parcel is obtained by early 

acquisition, the savings are $50,708,000. In case 7, the slope for the savings from early 

acquisitions somewhat stabilizes with a savings from early acquisitions of $124,593,000. The 

estimates for this Metro County scenario can be observed in Figure 17. 

 

 

Figure 17. Metro Project Costs and Savings under the “Schematics Available (time 0)” 
Scenario. 
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42 parcels are acquired early is $24,977,000. The difference between these two total costs, or the 
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Figure 18. Metro Project Costs and Savings under the “First Parcel Purchased (early)” 
Scenario. 
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Figure 19. Metro Project Costs and Savings under the “ROW Release Obtained” Scenario. 
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Table 14. Estimated Time Durations to Complete Right-of-Way Acquisitions. 
 
 

County 
Type 

Time Duration 
without Early 
Acquisition 

(months) 

Parcels 
Obtained by 

Early 
Acquisition 

Time 
Duration 

with Early 
Acquisition

(months) 

Reduction 
in Time 
(months) 

Time 
Reduction 

Ratio 

Metro 102.6 
1 102.2 -0.4 0.004 

7 100.3 -2.3 0.022 

42 36.1 -66.5 0.648 

Urban 76.8 
1 76.6 -0.2 0.003 

5 76.3 -0.5 0.007 

42 22.8 -54 0.703 

Rural 65.1 
1 64.9 -0.2 0.003 

2 64.8 -0.3 0.005 

43 17.4 -47.7 0.733 

Dallas 83.1 
1 82.7 -0.4 0.005 

5 81.6 -1.5 0.018 

28 26.1 -57 0.686 

Harris 78.5 
1 78.3 -0.2 0.003 

5 77.2 -1.3 0.017 

24 23.5 -55 0.701 

Tarrant 60.3 
1 60.3 0        0 
6 60.1 -0.2 0.003 
40 14.5 -45.8 0.760 

 

CONCLUSIONS FROM SENSITIVITY ANALYSIS 

Project Costs and Savings 

Table 15 displays a summary of maximum costs and savings for all five speculation-

begin scenarios. Data includes total project costs without early acquisitions, total project costs 

with all parcels acquired early, and total expected savings from early acquisition if all parcels 

were acquired early. The cost savings ratio shown in the last column is the total expected savings 

with all parcels acquired early divided by the total project cost without early acquisition. Dallas 

shows the highest cost savings ratios followed by Metro. The lowest cost savings ratio occurred 

for the Rural project, as would be expected. It is also observed that for all projects the highest 

Submittal



 

54 
 

increased cost savings ratio occurs for the scenario when speculation begins as soon as 

schematics become available. This is also an expected finding as that scenario exposes the 

parcels to speculation-related cost increases for the longest period of time. 

 

Table 15. Summary of Maximum Total Project Costs and Savings. 
 

 
Project 

 
Speculation Scenario 

Total Project 
Cost without 

Early Acquisitions 
($1,000) 

Total Project 
Cost with Early 

Acquisitions 
($1,000) 

Total Expected 
Savings from Early 

Acquisitions 
($1,000) 

Cost 
Savings 
Ratio 

Metro 

Environmental Clearance Obtained $147,320 $26,812 $120,508 0.82 
First Parcel Purchased (not early) $147,320 $33,145 $114,175 0.78 
Schematics Available (time 0) $147,320 $25,355 $121,965 0.83 
First Parcel Purchased (early) $147,320 $35,830 $111,490 0.76 
ROW Release Obtained $147,320 $28,065 $119,255 0.81 

Urban 

Environmental Clearance Obtained $11,817 $4,652 $7,165 0.61 
First Parcel Purchased (not early) $11,817 $5,109 $6,708 0.57 
Schematics Available (time 0) $11,817 $4,440 $7,377 0.62 
First Parcel Purchased (early) $11,817 $5,311 $6,506 0.55 
ROW Release Obtained $11,817 $4,806 $7,011 0.59 

Rural 

Environmental Clearance Obtained $1,967 $1,513 $454 0.23 
First Parcel Purchased (not early) $1,967 $1,595 $372 0.19 
Schematics Available (time 0) $1,967 $1,435 $532 0.27 
First Parcel Purchased (early) $1,967 $1,618 $349 0.18 
ROW Release Obtained $1,967 $1,550 $417 0.21 

Dallas 

Environmental Clearance Obtained $88,764 $14,254 $74,510 0.84 
First Parcel Purchased (not early) $88,764 $17,352 $71,412 0.80 
Schematics Available (time 0) $88,764 $13,498 $75,266 0.85 
First Parcel Purchased (early) $88,764 $20,283 $68,481 0.77 
ROW Release Obtained $88,764 $14,997 $73,767 0.83 

Harris 

Environmental Clearance Obtained $381,424 $93,099 $288,325 0.76 
First Parcel Purchased (not early) $381,424 $105,486 $275,938 0.72 
Schematics Available (time 0) $381,424 $89,884 $291,540 0.76 
First Parcel Purchased (early) $381,424 $110,906 $270,518 0.71 
ROW Release Obtained $381,424 $95,635 $285,789 0.75 

Tarrant 

Environmental Clearance Obtained $138,718 $60,801 $77,917 0.56 
First Parcel Purchased (not early) $138,718 $70,145 $68,573 0.49 
Schematics Available (time 0) $138,718 $55,774 $82,944 0.60 
First Parcel Purchased (early) $138,718 $72,865 $65,853 0.47 
ROW Release Obtained $138,718 $64,354 $74,364 0.54 

 

Time Durations for Acquiring All Parcels 

The project with the longest time duration for acquiring all parcels, without early 

acquisition being employed, is Metro with 102.6 months. Tarrant was observed to have the 

shortest time duration at 60.3 months.  The highest time reduction factor (0.760) occurs for 
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Tarrant when all parcels are acquired early. In all projects, it was found that the time reduction 

factor increases as would be expected as the number of parcels acquired early increases. 

Summary of Sensitivity Testing Findings 

No anomalies or unexpected results were identified by the limited TAMSIM sensitivity 

testing performed at the conclusion of this project. The performed sensitivity testing is not 

considered adequate in itself to assure proper TAMSIM modeling and choice of statistical 

attribute factors. TAMSIM results obtained during initial implementation activities should be 

closely observed and compared to results expected by experienced district ROW procurement 

personnel. Adjustments to better improve simulation may be expected, although major 

adjustments are not anticipated. 
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CHAPTER 5:  
EROW: AN OPTIMIZATION PROGRAM FOR DETERMINING BUDGET 

ALLOCATION FOR EARLY RIGHT-OF-WAY ACQUISITIONS 

 
Given the total budget available for purchasing right of way, the rate of return for 

alternative use of right-of-way budget funding, and the TAMSIM output for different early 

acquisition scenarios of right-of-way projects under consideration, it is possible to determine 

which of the available project options should be pursued. In so doing, an optimal overall budget 

for early right-of-way acquisition is also determined. This chapter describes the proposed 

optimization approach designed for this purpose and its software implementation, EROW.  

INTRODUCTION TO EROW 

The TAMSIM simulation tool described in the previous chapter provides a convenient 

method of estimating expected costs and savings resulting from early acquisition of a specified 

number of parcels included in a given right-of-way project. This information can be utilized in 

deciding how many parcels, if any, should be acquired early for the considered project. One 

could argue that with a small number of potential early acquisition scenarios for a given project it 

should be relatively easy to select the best one to be pursued for that project, say, by performing 

an incremental rate of return analysis. However, such a choice may not be optimal from the 

district-wide or statewide perspective, when numerous other projects and options are taken into 

consideration. To obtain a broader based optimal solution, all available options for the same 

project must be considered within a system-level optimization model, which ensures that at most 

only one of the options corresponding to each considered project will be selected in the optimal 

solution. As a result, the project option selected in the system-level optimal solution may not 

compare favorably to other options for the same project possible when overarching budget 

limitations and other projects are not considered. Thus, the problem becomes much more 

complex when the number of projects is large and budget constraints are taken into account. In 

fact, the resulting combinatorial optimization problem, the multiple choice knapsack, is known to 

be NP-hard, meaning that the problem is computationally intractable in theory. Despite this 

discouraging theoretical property, researchers effectively solve the problem in practice by using 

pseudo-polynomial dynamic programming (DP) algorithms. The run time of such algorithms 
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scales well with the increase in the number of projects and available options for each project, 

with potential complications possible only when the available budget is extremely large. 

However, this potential complication can be handled by minimally reducing the model’s 

precision with respect to possible budget levels considered. A degree of precision reduction 

should not be problematic from the practical perspective (e.g., neglecting the difference of 

$1,000 is acceptable with a billion dollar budget). The DP approach has several advantages over 

the mixed integer linear programming (MILP) model that the research team originally developed 

during initial stages of this project, namely: (i) rather than outputting the so-called benefit values, 

which can be difficult to interpret, DP can output the actual savings for all considered budget 

values; (ii) DP simplifies the usage of the benefit coefficients and allows for a much greater 

flexibility in selecting the benefit coefficients. In fact, any nonlinear function can be used 

without complicating the model; (iii) the DP algorithm is easy to implement and does not require 

use of off-the-shelf optimization packages. Based on these advantages, the dynamic 

programming approach became the method of choice for this application.   

The remainder of this chapter provides a brief background on dynamic programming and 

incremental rate of return analysis, which is followed by a description of the DP algorithm and a 

small example illustrating the approach. Next, the input data requirements are described. This is 

followed by a detailed description of EROW, the software package developed.  

BACKGROUND  

Dynamic Programming 

Dynamic programming is a methodology used to solve certain types of optimization 

problems. It was developed in the 1950s by Richard Bellman, who also wrote the first textbook 

on the subject (Bellman 1957). The idea is to solve a large-scale problem by breaking it down 

into a number of smaller problems, which can then be easily solved in a recursive fashion. Many 

of the problems solved using DP algorithms share the following common characteristics. 

 The problem can be subdivided into separate stages.  

 There are a number of states associated with each stage. 

 At each stage, a decision has to be made on how to transform the state at the 

current stage into the state at the following stage. 
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 An optimal decision at each state does not depend on the previous decisions or 

states (principle of optimality).  

 There is a recursive relationship representing the optimal decision for each state at 

stage i in terms of previously computed optimal decisions for states at subsequent 

stages i+1, i+2, … (for backward recursion). 

The resource allocation problem being dealt with in considering right-of-way budgets can 

be viewed as a version of the classical knapsack problem, which can be used to illustrate the DP 

approach. In the knapsack problem, a given a set of n items can be placed in a knapsack of a 

certain capacity W. Each item i is characterized by its size (weight) wi and its benefit bi. The goal 

is to find the quantity of each item to put in the knapsack to maximize benefits while staying 

within the capacity constraint. If xi is the quantity of item i to be included, then the problem can 

be formalized by the following integer program: 

 

maximize ෍ bi xi

n

i=1

                                                                                                4-1 

 
so that    ∑ wi xi

n
i=1   ≤   W,             

 
xi is a nonnegative integer.                               

 
                      

To solve this problem using DP, the first step is to define stages. For example, use n 

stages representing items. The state si at stage i represents the space still available for filling at 

this and consecutive stages, i.e., the total weight units available for items j, j+1, …, n to be 

placed in the knapsack. The decision at stage i is how many units of item i to place in the 

knapsack. This value is denoted as xi. Let fi (si) be the optimal benefit of using si units of capacity 

at stages i, i+1, …, n. This gives  

 

fiሺsiሻ= ൞
bn ඌ

sn

wn
ඐ , if i  =  n,

max൛bixi+fi+1
ሺsi-wixiሻห0   ≤    xi    ≤    

 si

wi
,  xi is integer}, if i < n,

                    4-2 
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where si = 0, 1, …, W for i=2, …, n and s1 = W. The problem is solved using backward recursion 

to compute f1(W). Similar ideas are used to solve the resource allocation problem, which is a 

multiple choice version of the knapsack problem.  

Incremental Rate of Return Analysis 

Incremental rate of return (IRR) analysis is a standard engineering economic method for 

comparing multiple mutually exclusive investment alternatives. In this method, one compares the 

rate of return on just the incremental increase in investment between the two compared 

investment alternatives to the specified minimum attractive rate of return (MARR). If the rate of 

return from just the additional amount of investment being considered is greater than the MARR, 

then the additional investment is worthwhile, and the second alternative including the additional 

investment is preferred. Otherwise, if the rate of return is less than MARR, the first alternative is 

more attractive. In this project, the incremental rate of return analysis process is incorporated to 

allow comparison of alternative early acquisition budget levels and in so doing to determine the 

optimal budget for early right-of-way acquisition.  

THE DYNAMIC PROGRAMMING APPROACH: FORMULATION AND EXAMPLE 

The following notation is used: 

 
N= the total number of projects considered; 

i   = index representing the project number, i=1,…, N; 

Si = the set number of considered early acquisition scenarios for project i; 

j  = index used for the scenarios, ݆ א ௜ܵ; 

cij = the cost of project i under scenario j;  

sij  = the savings for project i under scenario j;  

b  = a lower bound on the budget for early right-of-way acquisition (the default value 

is 0); and 

B  = the total available budget.  

 
If the binary variable is denoted by xij, such that xij=1 if the j-th scenario of project i is selected 

and xij=0, otherwise, then the multiple choice knapsack model can be formulated as the 

following integer program (IP):  
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maximize ෍ ෍ sij xij

 

jאSi

N

i=1

                                                                                            4-3 

so that        ∑ ∑ cij xij
 
jאSi

N
i=1 ≤  B, 

௜௝ݔ א ሼ0,1ሽ. 

 

Similarly with the DP approach for the knapsack problem outlined above, the stages will 

correspond to projects, and the state bi at stage i will represent the budget available for projects 1, 

…, i (note that unlike in the knapsack example, forward recursion is used instead of backward, 

however, the basic concept is identical). The recursive function viሺbiሻ at stage i expresses the 

maximum savings resulting from allocating the budget given by bi among the options available 

for projects 1, …, i. The decision at stage i is which of the options in ௜ܵ, if any, should be chosen 

so that the optimal savings of viሺbiሻ is achieved at stage i.  Next the recursive relation is defined 

that will be used to compute the values of viሺbiሻ. To simplify the formulation, an artificial stage 0 

is introduced, which corresponds to having no projects. It is also assumed that the first early 

acquisition scenario in each ௜ܵ corresponds to not picking project i, i.e., ci1 =si1= 0. Another 

important assumption is that only a discrete set of possible budget levels ܾ௜ is considered. 

Notation bi=b, …, B will mean that ܾ௜ takes on all possible budget levels (according to the 

corresponding discretization) between the minimum considered budget b and the maximum 

considered budget B. This provides the following recursive relation for each b i= 0, …, B: 

 

viሺbiሻ= ቊ,
0, if i = 0,

max൛sij+vi-1൫bi-cij൯ห jאSi}, if 0 < i ≤ n.
                                                     4-5 

 

By solving this recursion for all projects starting from the first project to the last, the 

computational results for vnሺbnሻ, bn=b,…, B,  will represent the optimal solution for all the 

considered budget increments. Next, the DP algorithm is illustrated with a simple small example. 
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A Simple Example 

Assume that the following cost and savings data are given for three projects, each of 

which has three possible scenarios as shown in Table 16 and Table 17, respectively. 

 

Table 16. Example Cost Data. 
 

Case Scenario 1 Scenario 2 Scenario 3 

Project 1 0 900 1700 

Project 2 0 1280 2050 

Project 3 0 2200 3950 

 

Table 17. Example Savings Data. 
 

Case Scenario 1 Scenario 2 Scenario 3 

Project 1 0 650 980 

Project 2 0 510 1150 

Project 3 0 1100 2200 

 

The computational results for the range of budget of $1,000 to $8,000 are demonstrated 

below. The values in parentheses at the end of each line represent the corresponding optimal 

decision, given by the number of the selected scenario. 

 

v1ሺb1ሻ:    

ە
ۖ
ۖ
ۖ
۔

ۖ
ۖ
ۖ
ۓ

v1ሺ1000ሻ = Maxሼ0,650ሽ = 650 (2)         
v1ሺ2000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
v1ሺ3000ሻ = Maxሼ0,650,980ሽ = 980 (3)   
v1ሺ4000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
v1ሺ5000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
v1ሺ6000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
v1ሺ7000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
v1ሺ8000ሻ = Maxሼ0,650,980ሽ = 980 (3)  
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v2ሺb2ሻ:   

ە
ۖ
ۖ
ۖ
۔

ۖ
ۖ
ۖ
ۓ

v2ሺ1000ሻ = Maxሼ0 + 650ሽ = 650  (1)                                                 
v2ሺ2000ሻ = Maxሼ0 + 980, 510 + 0ሽ  = 980 (1)                                   
v2ሺ3000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 650ሽ = 1800 (3)           
v2ሺ4000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 980ሽ = 2130 (3)           
v2ሺ5000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 980ሽ = 2130 (3)           
v2ሺ6000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 980ሽ = 2130 (3)           
v2ሺ7000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 980ሽ = 2130 (3)           
v2ሺ8000ሻ = Maxሼ0 + 980, 510 + 980, 1150 + 980ሽ = 2130 (3)           

        

 

v3ሺb3ሻ:   

ە
ۖ
ۖ
ۖ
۔

ۖ
ۖ
ۖ
ۓ

v3ሺ1000ሻ = Maxሼ0 + 650ሽ = 650 (1)                                                           
v3ሺ2000ሻ = Maxሼ0 + 980ሽ = 980 (1)                                                           
v3ሺ3000ሻ = Maxሼ0 + 1800, 1100 +0 ሽ = 1800 (1)                                       
v3ሺ4000ሻ = Maxሼ0 + 2130, 1100 + 980, 2200ሽ = 2200 (3)                          
v3ሺ5000ሻ = Maxሼ0 + 2130, 1100 + 980, 2200 + 650ሽ = 2850 (3)                
v3ሺ6000ሻ = Maxሼ0 + 2130, 1100 + 2130, 2200 + 980ሽ = 3230 (3)             
v3ሺ7000ሻ = Maxሼ0 + 2130, 1100 + 2130, 2200 + 1800ሽ = 4000 (3)            
v3ሺ8000ሻ = Maxሼ0 + 2130, 1100 + 2130, 2200 + 2130ሽ = 4330 (3)            

        

 
To determine the scenarios selected in the optimal solution, track back the scenarios 

listed in the parentheses at the end of each line above. For example, if B = $5,000, then the 

optimal solution is to pick scenario 3 for project 3, which leaves a budget of $5,000-$3,950 = 

$1,050 for projects 1 and 2. Since the selected budget increment is $1,000, look at the solution 

corresponding to v2ሺ1000ሻ above, which is to pick scenario 1 for project 2. Finally, the solution 

for v1ሺ1000ሻ is to pick scenario 2 for project 1. Table 18 summarizes the computational results. 

“Not Selected” is shown whenever the first scenario is picked. In addition to budget, cost figures, 

and savings figures, the corresponding incremental rate of return is also one of the outputs. 

Table 18. Summary of EROW Results. 
 

Budget 
Option 

($) 

Resulting 
Expenditures 

($) 

Resulting 
Savings 

($) 

Rate of 
Return 

(%) 
Project 1 Project 2 Project 3 

1000 900 650 72.22 Scenario 2 Not Selected Not Selected 
2000 1700 980 57.65 Scenario 3 Not Selected Not Selected 
3000 2950 1800 61.02 Scenario 2 Scenario 3 Not Selected 
4000 3950 2200 55.70 Not Selected Not Selected Scenario 3 
5000 4850 2850 58.76 Scenario 2 Not Selected Scenario 3 
6000 5950 3230 54.29 Scenario 3 Scenario 3 Scenario 2 
7000 6900 4000 57.97 Scenario 2 Scenario 3 Scenario 3 

8000 7700 4330 56.23 Scenario 3 Scenario 3 Scenario 3 
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It should be noted that when budget increments greater than 1 are involved, it can be 

thought of as if the increment represents one monetary unit. So, instead of using 1 dollar or 1 

cent, the value may be considered to be $1,000 or $10,000. As a result, the computed values are 

optimal only with respect to the selected increment value, and one could easily build a 

“pathological” example where the “real” optimal solution with an integer unit represented by $1 

is very different from the solution that is computed. However, such pathological cases are 

extremely unlikely with real life data. Moreover, the resulting error of the model can be 

neglected due to the nature of data input, which includes data obtained from simulation and 

therefore is not exact.   

INPUT DATA REQUIRED 

While the methodology described in this chapter is general in nature and can be used to 

determine optimal resource allocation decisions in many diverse applications, this discussion will 

concentrate on decision-making for early right-of-way acquisition. In the right-of-way context, 

one may have different pieces of information that can be used to forecast future land parcel 

prices, and the optimization approach can be effectively combined with the forecasted figures to 

determine the optimal resource allocation strategies, assuming that the forecasted figures are 

reasonable. The forecast data obtained from TAMSIM output for expected costs and savings for 

the early acquisition scenarios of interest will be used. This section describes the specific input 

parameters needed for EROW and the format of input data.  

Costs and Savings Data Files 

Recall that TAMSIM allows a user to select particular parcels within a given project that 

are subject to early acquisition and then provides estimates of the right-of-way cost for the 

project both with and without selected early acquisitions occurring. These values are used to 

compute the potential savings due to early right-of-way acquisition. By selecting different 

numbers of parcels for early acquisition, different early acquisition scenarios for each project are 

obtained. For each such scenario, two of the values generated by TAMSIM will be used: the 

expected cost of the project under the considered early acquisition scenario and the expected 

savings resulting from selecting the given early acquisition scenario. These two EROW inputs 

will be stored in two different EROW text files. To be congruent with TAMSIM output 
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nomenclature, these files will be named Costs.txt and Savings.txt, respectively, 

paralleling files Cost.out and Save.out generated by TAMSIM as described in the 

previous chapter. Note that one run of TAMSIM is performed for each early acquisition scenario. 

Therefore, if Sp different early acquisition scenarios are considered for a given project p, the 

resulting files Cost.out and Save.out will contain Sp numbers each (with Sp rows and one 

number per row). All Sp numbers from file Cost.out will be recorded in the p-th row of file 

costs.txt, with a space separating two consecutive figures. For example, if Cost.out for 

project p is given by 

35000 

32000 

48000 

then the p-th row of the corresponding costs.txt file will be given by 

0   35000   32000   48000 

 
Note that 0 is shown as the first element of each row to represent the case when the 

project is not selected. The p-th row of the file savings.txt is obtained from the 

corresponding Save.out file in exactly the same fashion. Thus, if a total of P potential right-

of-way projects are considered in the budget analysis, with Sp early acquisition scenarios for each 

project p, where p=1,…, P, then the resulting files costs.txt and savings.txt will each 

contain P rows, with the p-th row containing Sp numerical values. Note that different numbers of 

entries may occur in different rows of the same file. However, it is crucial that the number of 

entries in the p-th row of costs.txt is exactly the same as the number of entries in the p-th 

row of file savings.txt. 

EROW: A SOFTWARE IMPLEMENTATION OF THE PROPOSED APPROACH  

The DP algorithm with incremental analysis described above has been implemented in 

C# programming language. The user interface of EROW consists of two screens, PROJECT 

INPUTS and RESULTS. 

Submittal



 

66 
 

Project Inputs Screen 

Figure 20 shows a snapshot of the project inputs screen. The input parameters that need 

to be specified in the PROJECT INPUTS screen include the maximum and minimum considered 

early acquisition budgets and the budget increment size (the interval between budgets to be 

considered between the maximum and minimum values). These inputs have a crucial impact on 

program run time. The run time decreases with an increase in the value of budget increment, 

however the tradeoff is that the model’s precision decreases in that situation. One could begin the 

analysis by considering a relatively large budget range and a relatively large budget increment. 

From the results output, identify promising smaller budget ranges, and then pursue the smaller 

range or ranges with a smaller budget increment value.  

 

 
 

Figure 20. EROW Project Data Entry Screen. 
 
 

The other data inputs are the costs and savings files (the example in Figure 20 uses the 

input files costs.txt and savings.txt included with the EROW distribution). The 

RESULTS OPTIONS box allows the user to select whether or not the project scenarios 

providing the best rate of returns for each possible budget solution will be displayed on the 

RESULTS tab.  A second check box is offered to require EROW to perform an IRR and compare 
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each resulting value to the specified MARR. When an IRR for a considered early acquisition 

budget does not exceed the MARR value, that budget amount is removed from solution 

consideration. The STATUS window displays the most recent important actions performed.  

 Pressing the SOLVE button at the bottom of the screen causes the program to run in the 

manner specified, and the RESULTS screen is automatically displayed at the conclusion of the 

program run. 

Results Screen 

Figure 21 displays the RESULTS screen from the Figure 20 input data. 

 

 
 

Figure 21. EROW Results Screen. 
 

The table in this screen shows the optimal solutions corresponding to different early 

acquisition budget alternatives. The columns in this table have exactly the same notations and 

meaning as those in Table 18. The Summary box shows the rate of return, budget required, and 

total savings values for budget solutions corresponding to the best rate of return and the 

maximum savings possible within the specified budget range. Finally, the user can save the 

results in a text file by pressing the SAVE RESULTS button. The results can also be viewed 

graphically through the PLOT RESULTS button.  
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Plots for Rate of Return and Savings versus Budget  

Figure 22 shows graphically displayed results from the data in Figure 21. 

 

Figure 22. EROW Output Plot Example. 
 

As can be seen from this figure, there are several budget intervals with peaks that the user 

may want to analyze in greater detail by decreasing the uncertainty interval for the budget and 

decreasing the budget increment value. Peaks indicate favored budget solutions from a rate of 

return standpoint. As noted in Figure 22, the highest rate of return may occur at a budget solution 

rather low in the allowable budget range for the analysis. When this occurs, it is more likely that 

the user will prefer a somewhat lower rate of return at a considerably higher early acquisition 

budget considering the increased total savings that can be obtained as well as the time duration 

benefits of acquiring a greater number of parcels for the group of projects being analyzed. 

Wherever the peaks occur, the represented budget options offer rate of return advantages over 

the budgets represented by valleys in the chart. 
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Help Information 

EROW contains a Help section to provide the user with additional information and 

facilitate use of this tool. The Help information explains user options, necessary data entries, and 

the displays of results obtained from an EROW run. EROW also contains an About button, 

displaying appropriate tool identification and credit information. Information provided under 

Help is included in Appendix C. 
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CHAPTER 6:  
DECISION-SUPPORT TOOLS IN OTHER AREAS OF TXDOT 

RESOURCE ALLOCATION DECISION MAKING 

 

Simulation and optimization business science methods have been found suitable for the 

development of decision-support tools regarding resource allocation. The research team was 

requested to explore the potential of applying a similar approach to that developed for right-of-

way acquisition budget decisions to assist TxDOT in optimizing fleet-level equipment 

replacement decision-making. 

THE FLEET-LEVEL EQUIPMENT REPLACEMENT ISSUE 

 
The problem of designing an optimal strategy for replacing old equipment with new often 

arises in practice. In fact, it is one of the most important aspects of fleet management, which is a 

process focused on reducing overall costs associated with operation of an organization’s vehicle 

fleet. In addition to cost savings, having effective equipment replacement policies is important 

for determining adequate funding levels, especially in governmental organizations. For example, 

funding below the optimal level may result in higher maintenance costs due to greater use of 

aged equipment. There were also previous research projects conducted for TxDOT to develop an 

automated fleet level equipment replacement methodology. A brief summary of optimization 

techniques for designing optimal equipment replacement policies and the previous TxDOT 

research projects in this area follows. 

OPTIMIZATION TECHNIQUES FOR DESIGNING OPTIMAL EQUIPMENT 
REPLACEMENT POLICIES 

As with many other decision-making problems, optimization techniques can be applied 

for designing adequate equipment replacement policies. Of course, in order to use the powerful 

optimization techniques effectively for this purpose, one needs to have appropriate information 

about the factors that influence the asset’s lifecycle and the corresponding costs associated with 

the lifecycle. Even though some of these factors may be difficult to predict due to uncertainties 

associated with demand variability and technological change, in many cases the corresponding 
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probability distributions can be estimated based on historical data for a particular type of 

equipment.  

Brief Overview of Existing Optimization Techniques  

Due to the time-dependent nature of the problem, dynamic programming has come to the 

forefront as the most popular optimization technique for decision-making on equipment 

replacement. The DP methodology was developed in the 1950s by Richard Bellman to deal with 

optimization problems that can be broken into smaller sub-problems, which can then be solved 

recursively so that the solution to the last sub-problem solved yields an optimal solution to the 

original problem. The first basic DP approach to the equipment replacement problem was 

proposed by Bellman in 1955. This approach assumes that the machine’s operating 

characteristics, output and maintenance cost as a function of time; the trade-in value as a function 

of time; and the purchase price are given. Then, simple DP equations can be written to determine 

a replacement policy maximizing the overall return from a machine over a given time horizon. 

The model allows for an easy incorporation of technological improvement considerations. Even 

though this model is very simple and does not make allowances for the uncertainties involved, its 

basic principle can be applied to develop much more realistic models. In fact, the models 

proposed in multiple publications that followed the seminal Bellman paper can be viewed as 

extensions of the basic Bellman model (Hartman 2004; Hartman and Murphy 2006). In 

particular, Hartman (2004) proposed a stochastic DP approach that assumes variable asset 

utilization and stochastic demand. On the other hand, if the funding is limited, one needs to 

adjust the equipment replacement strategy to operate under the capital budgeting constraints 

(Karabakal et al. 1994).   

In another interesting recent paper, Hritonenko and Yatsenko (2008) study the impact of 

technological change on the optimal asset lifetime and show that a more intensive technological 

change may result in both an increase and decrease of the optimal lifetime of assets. Rajagopalan 

(1998) proposes a unified model for optimal capacity expansion and equipment replacement. He 

shows that even though the general problem is computationally hard, efficient algorithms are 

possible under certain assumptions. 
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Automated Fleet Level Equipment Replacement Methodology (TxDOT Report 4941-2) 

 This research was conducted by the University of Texas in San Antonio. Report 4941-2, 

published in 2003, describes the methodology and summarizes researcher findings (Weissmann 

and Weissman 2003).  Comments about the methodology developed under TxDOT research 

Project 0-4941 follow. 

Optimization Criterion 

Assume that the optimization criterion is to be the total discounted expected cost over an 

infinite time horizon. For this purpose α < 0 will be the discount factor; that is, α is the present 

value of $1 a year from now. 

Optimal Replacement Time for One Vehicle 

Before considering the fleet, first determine how to obtain the optimal replacement time 

when considering only one vehicle. The assumption is that a fleet vehicle was purchased one or 

more years ago. When it is replaced, it will be with a new vehicle that is probably not equal to 

the current vehicle due to improvements in vehicles. However, because of the uncertainty of the 

future, it is assumed that the replacement vehicle will eventually be replaced by another 

equivalent vehicle ad infinitum. 

Optimal Replacement Time for a New Vehicle 

Let f(n) denote the present value of the expected life-cycle cost for the vehicle that is 

purchased in year zero and sold at the end of year n. Thus, 

 

fሺnሻ = PC  + ෍ αiACn - αnRS

n

i=1

                                                                            5-1 

                                               

where PC is the purchase price, RS is the expected resale value, and ACi is the expected annual 

cost for year i that includes repair costs, operational costs, indirect costs, and costs of downtime. 

The equivalent uniform annual life-cycle cost is given by 
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EUACn = fሺnሻ 1-α

α൫1-αn൯
                                                                                                 5-2                

                                 

The optimal replacement time is found by obtaining the value of n that minimizes        

Eq. (5-2). Another equivalent method of writing the optimal replacement time is to minimize the 

following total discounted cost given by 

 

fሺnሻ + αnfሺnሻ + α2nfሺnሻ + … 

 

since this represents always replacing the vehicle with an identical vehicle. Thus, the optimal 

replacement age is to find the value of n that minimizes the following objective function 

 

Fሺnሻ = f(n)

1-αn                                                                                                             5-3     

Optimal Replacement Time for a Currently Operating Vehicle 

There are two major differences between a new vehicle and a currently used vehicle that 

is being considered for replacement: 1) the purchase price of the currently used vehicle is a sunk 

cost and therefore irrelevant, and 2) its replacement may have different characteristics. Let us 

assume that the replacement vehicle has been analyzed, its optimal replacement time, if 

purchased now, is given by n,* and the total discounted cost is given by F new  (n
*). Thus, the 

optimal replacement time for the existing vehicle is the value of n that minimizes 

 

Foldሺnሻ = ෍ αiACn - αnRS + αnFnew(n*)

n

i=1

                                                          5-4 

 

where AC n and RS refer to the annual cost and resale value of the current vehicle. Eq. (5-4) gives 

the objective function for one vehicle, so for a fleet, similar equations for each vehicle within the 

fleet are combined. 
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Comments 

a. Report 0-4941-2 uses Eq. (5-2) to identify the optimal age assuming that “Ideally, any 

equipment should be replaced right before the point where the EUALCC equals the 

purchase cost of a new unit.” The question is why to recommend waiting beyond the 

optimal replacing age? If budget limitations cause delay in vehicle replacement, then the 

approach of report 0-4941-2 of choosing based on which vehicle is furthest beyond the 

optimal age seems reasonable; however, if budget causes the delay in optimal age 

purchasing, it is ultimately causing increased costs. 

 

b. It is easy to see that Eq. (5-2) and Eq. (5-3) yield the same optimal age, but it is not 

obvious that Eqs. (5-2) and (5-4) would yield the same age if the annual costs and resale 

value of the new and old vehicle were the same. Since it may be difficult to estimate the 

cost of the replacement vehicle, using Eq. (5-2) may be a reasonable approach. However, 

if it is possible to estimate the new vehicle’s expected costs, then using Eq. (5-4) would 

be better. 

 

c. The trend score approach in report 0-4941-2 (Eq. (4.9) on p. 38) is not particularly robust 

as it will stay negative beyond the optimal age of replacement. Since the report indicates 

that a negative trend score implies a low priority for replacement, a vehicle would never 

be replaced at its optimal age. However, again, if the budget limits replacement 

purchases, this approach may be reasonable. 

 

d. Statistical analysis is desired to predict future costs based on historical costs. In other 

words, since maintenance costs are likely correlated, it may be possible to continually 

update the predictions of future costs. 

 

e. The “Statistical Analysis of Attributes’ Contribution to Replacement Priority” gives clear 

directions on establishing appropriate weights. If weights are a good idea, then more 

advice needs to be given on the selection of these weights. It makes sense for managers to 

adjust the weights, but they should start with initial weights based on an analysis of 

optimal replacement decisions. 
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FLEET ASSET MANAGEMENT RECOMMENDATIONS 

Several recommendations are offered. 
 

a. It would be extremely beneficial to have a simulation of fleet operating characteristics 

and costs to validate or refine fleet replacement policies. 

 

b. Optimization techniques, deterministic and stochastic, are very common in fleet 

management in general and in equipment replacement in particular, and using stochastic 

dynamic programming for this purpose seems to be especially natural and appealing.  

 

c. Because of the size of the problem, it is likely that some form of heuristic or 

approximation method will be necessary to use in conjunction with the stochastic 

dynamic programming approach. 
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CHAPTER 7:  
IMPLEMENTATION PLAN 

APPLICATIONS FOR TAMSIM AND EROW 

Beneficial tool applications are anticipated at the statewide budgeting level, at the district 

project planning level, and at the project level concerning desirable right-of-way acquisition 

timing for individual parcels of property. The TAMSIM and EROW tools are also envisioned for 

use in estimating potential statewide right-of-way cost savings under various legislative decision 

scenarios.   

Statewide Planning 

As TAMSIM is designed as a project-level tool, development of statewide planning 

information will require use of TAMSIM at the project and district levels, then aggregating 

collected information. In some cases, use of a statewide representative set of generic projects 

may be used for statewide planning purposes. 

Legislative Data Applications 

TAMSIM and EROW have the capability of estimating cost savings to the State of Texas 

should legislation of various types be passed to allow broadened use of early acquisition of right-

of-way parcels. To facilitate these estimations, it is suggested that a test pool of representative 

projects be developed from the entire group of projects currently in planning, statewide, which 

involve right-of-way purchasing. The test pool should include a known percentage of the 

statewide population of projects. All regions and population variables should be included in the 

project pool. In this manner, a reasonable estimation will be obtainable while limiting the efforts 

involved in making the cost-saving estimations.  

Statewide Budget Planning Applications 

TAMSIM and EROW will provide input to decision-makers determining the amount of 

budget that should be allocated for early acquisition of right of way, whether new legislation 

expands the use of this practice or not. Use of these tools for this purpose involves district-level 

tool application on all projects in each district which have probability of providing cost savings 

through utilization of early acquisition. The district-level information can then be aggregated at 
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the headquarters level for determining both the statewide budget for early right-of-way 

acquisition and the allocation of this budget among the districts.  

District-Level Planning 
Once an early right-of-way acquisition budget has been established for a district, that 

district can use TAMSIM and EROW to assist them in determining which projects and parcels 

should be pursued for early acquisition to obtain the greatest rate of return from their early right-

of-way acquisition budget. 

Other District-Level Uses 
It is likely that additional beneficial uses of particularly the TAMSIM tool will be 

identified when these tools are demonstrated and training is provided to district right of way and 

project planning personnel. One such potential additional use is to use TAMSIM to develop 

initial right-of-way cost estimates needed by project planners very early in the project planning 

process.  

FIRST USE AND TRAINING 
One of the most effective methods of tool training is hands-on use in cooperation with an 

experienced individual. The implementation plan for TAMSIM and EROW includes the 

selection of one district from each of TxDOT’s four regions. District planning and right-of-way 

section personnel from these districts will each be walked through the use of these tools by the 

research team. Actual project and right-of-way parcels will be used, thereby achieving the dual 

goals of training district personnel in use of tools and providing these districts beneficial 

information as they move to actual parcel acquisitioning. Workshops will then be held in each 

region to train TxDOT personnel from other districts in the regions. It is anticipated that insight 

will be obtained from these four tool applications into potential statewide cost savings if new 

legislation allows broadened use of early right-of-way acquisition. 

WORK PLAN 
The recommended implementation plan includes the following four tasks: 

 
Task 1. Cooperative Initial Use of TAMSIM and EROW. Four districts will be selected 

and contacted in consultation with the implementation project director and the ROW Division to 

become initial users of the newly developed tools. A district will be selected to represent each 
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TxDOT region. Preference will be given to urban and metropolitan districts with a history of 

rapid escalation in right-of-way parcel costs due to speculative purchasing and/or property 

improvements by landowners. 

The research team will make a presentation to each selected district to: 

 explain the purposes for which TAMSIM and EROW were developed, 

 explain simulation and optimization business science tool basics, 

 describe data input needs to use the tools, 

 facilitate selection of several local projects or a small corridor to be evaluated using these 

tools,  

 plan and schedule cooperative gathering of needed project and parcel information, and to, 

if possible, 

 tentatively establish a date for the regional workshop to be hosted by the district. 

The research team will then work with district planners and right-of-way section staff in 

each district to collect necessary project-level and parcel-level information. Any information 

available in ROWIS will be collected first by the research team, working through the ROW 

Division and/or district office to obtain appropriate ROWIS data files.  

Upon completion of gathering project and parcel data and statistics from ROWIS and 

district files, the research team will schedule a visit to the district for the purpose of 

photographing parcels and obtaining the district’s assessment of likelihood that each parcel may 

experience property improvements prior to department acquisition. An assessment will also be 

obtained from district right-of-way section staff of likelihood of other speculative activities. The 

participation of local right-of-way section specialists in these assessments is absolutely essential 

to successful use of the software tools being implemented. 

The research team will input gathered information and will demonstrate use of TAMSIM 

and EROW to each district participating in initial tool use, thereby providing tool output for 

district consideration as planning for the selected projects or short corridor moves forward. 

Task 2. TAMSIM and EROW Regional Workshops. Up to four regional workshops will 

be planned and delivered by the research team. Workshops will be held during the summer of 

2010. The objective of these workshops is to provide training in use of TAMSIM and EROW to 

other districts in each TxDOT region. The host district for which the tools were initially utilized 

will have the opportunity to participate in presenting regional workshop information. It is 
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anticipated that the analysis performed earlier in the year for the host district will be used to 

demonstrate use of the tools during each workshop. 

Workshops will be approximately four hours in length. As a minimum, the agenda will 

include: 

 explanation of the purposes for which TAMSIM and EROW were developed, 

 explanation of simulation and optimization business science tool basics, 

 description of data input needs to use the tools, and a 

 demonstration of each tool. 

Each district attending a regional workshop will be provided a CD-ROM containing 

TAMSIM, EROW, and a User’s Guide for each. 

Task 3. Tool Calibration Adjustments. It is anticipated that use of these tools in the four 

districts may allow minor adjustments in tool calibrations. If this is the case, these adjustments 

will be described in the implementation report. Major adjustments and enhancements to the tools 

will not be possible during this implementation project. 

Task 4. Implementation Report Preparation.  An implementation report describing project 

activities will be submitted at the end of this implementation project.  
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CHAPTER 8:  
CONCLUSIONS AND RECOMMENDATIONS 

 
Minimizing the cost of right-of-way acquisition and speeding construction completion 

time are high-priority objectives of TxDOT. The acquisition of right of way for a highway 

construction project can impact a project through both time and cost. Potential benefits from 

advantageous early right-of-way acquisitions are believed to be quite substantial in terms of both 

tax dollar savings and construction project predictability and completion time. While quantifying 

these benefits in monetary terms is a challenging task, obtaining a much better estimate and 

understanding of the potential impact that early right-of-way acquisition would have on project 

costs is needed.  

Researchers developed two right-of-way acquisition decision-support tools in this 

project: a simulation tool and an optimization tool. These tools rely on models developed from 

historical data stored in ROWIS and interviews conducted with TxDOT right-of-way personnel. 

TOOLS AND POTENTIAL TXDOT USERS 
TAMSIM is designed to provide statistical measures of the impacts that right-of-way 

acquisition timing can have on a project. It simulates right-of-way related activities and costs for 

a project during the Plan Authority and Develop Authority phases of project development, both 

with and without use of early acquisition. These costs include not only the purchase of the right 

of way itself, but also cost estimates associated with the possible delay in construction start time 

due to lack of right-of-way availability. TAMSIM also estimates right-of-way acquisition time 

durations, taking into account the randomness inherent in the acquisition process, such as the 

possibility of condemnation proceedings, the length of time for negotiations, and the costs 

involved in taking possession of the parcels.   

EROW is the optimization tool designed for estimating the most desirable right-of-way 

dollar-value to be allocated for early purchase of right-of-way parcels. It enhances TAMSIM 

capabilities. Additional uses of EROW are likely as the level of experience with this tool grows. 

It may become possible for experienced users to determine on a statewide basis the projects that 

offer the best return on investments within certain budget restrictions. 

TAMSIM is designed for use by knowledgeable right-of-way professionals at the district 

level to determine the likely results on a specific project if some of its parcels were acquired 
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early. It can also be used as a policy supporting tool at the state level to compare the potential 

effects on project costs of various proposed policies regarding early acquisition of right of way. 

Outputs produced by TAMSIM can be compiled into a pair of files including information on 

each project investment scenario included in the analysis. EROW can use these files at the 

district or the state levels to determine how much money would optimally be allocated to early 

right-of-way acquisition and which projects should receive funding for early acquisition. For a 

state level application, inputs from right-of-way administrators at the district level are critical in 

order to generate dependable estimated cost information for each right-of-way project investment 

scenario.  

The tools developed during phase two of this project, TAMSIM and EROW, are included 

on a CD-ROM in a jacket inside the cover of this report. 

CONCLUSIONS 
1. Simulation and optimization business science methods have been found suitable for the 

development of decision-support tools regarding early acquisition of right-of-way 

parcels.  

2. Two tools were developed in this project: TAMSIM and EROW. These tools can assist 

decision makers at the district and state levels in the funding allocation process for early 

right-of-way acquisition.  

3.  TAMSIM and EROW can support the following activities: 

a. Determination of the probability of significant savings from early acquisition on a 

single project and estimating the magnitude of that savings. 

b. Determination of the number of parcels within a given project which should be 

considered for early acquisition. 

c.  Determination of which projects within a district offer the most potential for 

significant savings from early acquisition. 

d.  Determination on a statewide basis an optimal number of parcels or projects or right-

of-way dollar-value to be allocated for early acquisition of right of way.  

4. Based on TAMSIM sensitivity testing, TAMSIM provides cost saving results in correct 

relative magnitude sequence. Earlier times for speculation to begin result in greater 
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savings potential from early acquisition. The greatest cost savings occur when 

speculation activities begin immediately after the schematics become available. 

5. Findings from the TAMSIM sensitivity analysis performed to consider speculation 

beginning when the schematics become available are shown in Table 19. The highest 

expected savings in terms of dollars are in the Dallas project while the highest time 

reduction to procure needed right of way is anticipated by TAMSIM to occur in the 

Tarrant project.  

 

Table 19. Costs, Savings, and Time Durations for Speculation Scenario Providing Greatest 
Benefits 

 

County 
Type 

Speculation-Begin 
Scenario 
Providing 

Greatest Early 
Acquisition 

Benefits 

Total Right-
of-Way Cost 

without 
Early 

Acquisitions 
($1,000) 

Total Right-
of-Way Cost 
with Early 

Acquisitions 
($1,000) 

Total 
Expected 

Savings from 
Early 

Acquisitions 
($1,000) 

Cost 
Savings 
Ratio 

Time 
Duration 

without Early 
Acquisition 

(months) 

Time 
Duration 

with Early 
Acquisition 

(months) 

Time 
Reduction 

Ratio 

Metro 
Schematics 
Available  
(time 0) 

$147,320 $25,355 $121,965 0.83 102.6 36.1 0.648 

Urban 
Schematics 
Available  
(time 0) 

$11,817 $4,440 $7,377 0.62 76.8 22.8 0.703 

Rural 
Schematics 
Available  
(time 0) 

$1,967 $1,435 $532 0.27 65.1 17.4 0.733 

Dallas 
Schematics 
Available  
(time 0) 

$88,764 $13,498 $75,266 0.85 83.1 26.1 0.686 

Harris 
Schematics 
Available  
(time 0) 

$381,424 $89,884 $291,540 0.76 78.5 23.5 0.701 

Tarrant 
Schematics 
Available  
(time 0) 

$138,718 $55,774 $82,944 0.60 60.3 14.5 0.760 

 

6. The use of asset management practices for right-of-way early acquisition can be 

technically justified, but there may be limitations to implementation potential. 

Availability of funds for purchase of right of way is a concern in Texas. Parcels which 

are identified as beneficial for early acquisition may not be within TxDOT budgeting 

ability to purchase early.  

7. To maximize benefits possible through early acquisition, laws and policies will need to 

be modified to allow early acquisition with less restriction than is currently allowable.  

Asset management tools used for estimating the benefits of right-of-way early 
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acquisition, when applicable, will assist in improving communication with legislators if 

legislative changes are considered in the future. 

RECOMMENDATIONS  

1. TxDOT should implement TAMSIM and EROW on a statewide basis for the initial 

purpose of assisting in selection of right-of-way parcels for early acquisition within the 

current limitations of state legislation. 

2. Initial results provided to TxDOT by TAMSIM and EROW during the implementation 

period should be analyzed by TxDOT right-of-way professionals to allow model 

adjustments as may be found desirable. 

3. A pool of representative projects should be assembled for use in estimating potential cost 

savings for the State of Texas should various new allowances be provided through future 

legislation. 

4. In the opinion of TxDOT personnel with experience in right of way, the following are 

general recommendations for applying asset management principles to right-of-way early 

acquisition: 

a. Projects should be studied case-by-case to determine if early acquisition will be 

beneficial. 

b. Protective buying can save money if: 1) parcels are located in an area where cost can 

increase rapidly, 2) a significant number of parcels are purchased, and 3) parcels are 

acquired early enough to avoid speculation and/or improvements being added to the 

properties. 

c. Buy parcels when they are vacant. It is not recommended to wait for improvements in 

the parcels. Any improvement will cause the cost to increase. 

d. Speculation, improvements to the property, and damages to the remainder of the 

property are considered to be the major factors causing significantly increased land 

cost. 

e. Right-of-way early acquisition may foster smoother negotiations, saving time and 

human resources. 
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f.  Good communication with cities and counties will help to identify areas where right-

of-way cost can increase significantly from initial estimates. This will allow districts 

to take action to minimize the impact of potential cost escalation. 
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APPENDIX A – FILTERED ROWIS DATA SETS 

 

A CD-ROM containing filtered right-of-way acquisition data sets used to establish 

simulation data attributes is enclosed in a jacket inside the cover of this report. 
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APPENDIX B – TAMSIM HELP INFORMATION 

 

About TAMSIM 

TAMSIM is a simulation program for developing total right-of-way (ROW) cost estimate 
information during early project planning activities.  It is designed for use by experienced Texas 
Department of Transportation (TxDOT) project planners and ROW acquisition personnel.  This 
tool allows users to determine the potential for achieving significant cost savings under various 
ROW acquisition timing strategies. 

TAMSIM utilizes embedded statistics developed from historical department ROW acquisition 
records together with user-provided project and parcel information to generate total cost estimate 
information in present value dollars.  The range of outcomes as well as the most likely outcome 
is determined through simulated occurrences of ROW acquisition for the parcels within the 
analyzed project.  TAMSIM defines time zero of the acquisition time line as the point in 
planning when the initial schematics indicating the parcels to be obtained become available. 

TAMSIM was created for TxDOT by the Texas Transportation Institute (TTI) of the Texas 
A&M University System under TxDOT Research Project 0-5534.  TAMSIM was designed and 
developed by: 

Carlos M. Chang-Albitres, Don Hun Kang, Paul E. Krugler 
of the  

Texas Transportation Institute 

and 

Richard M. Feldman 
of the 

Industrial and Systems Engineering Department 
Texas A&M University 

Version:  1.0 
Copyright 2009 
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Alignments 

 An alignment refers to a collection of parcels that will be accepted or rejected as a unit during 
the environmental clearance process.  Because TAMSIM is designed to be used before the 
environmental clearance has been obtained, there is a possibility that some of the parcels listed 
will not be included in the final corridor and those parcels that are accepted or rejected together 
form an alignment.   The designation of which parcel belongs to specific alignments is made on 
the Parcel Data Screen. 

Alignments are organized into groups such that one, and only one, alignment from the group will 
be accepted for the final approved corridor.  Alignments within one group must always be listed 
consecutively within the Alignments Screen with the first alignment of each group being 
identified by a check box. 

The Alignments Screen 

The Alignments Screen allows for input or modification of alignment specific data.  It also 
contains four menus:  the File Menu, which is the same as the “Quit” Button; the View Menu 
used to view and/or modify data; the Run Menu, which is the same as the “Continue” Button to 
execute the simulation model; and the Help Menu for accessing the help system.  The list of 
shortcut keys can also be accessed from the Help Menu.  Two of the three buttons on the screen 
are redundant and are placed on the screen for ease of use.  Clicking the “Continue” Button will 
continue the simulation to the Basic Data Screen and is equivalent to using the Run Option (or 
the F5 key); clicking the “Quit” Button is equivalent to using the Exit Option (or <ctrl>+X).  
You can also quit the application by clicking the “x” in the upper right corner of the screen; 
however, using the close box on the screen will cause you to lose any unsaved data, and no 
warning message is given asking if you want to save your data.  The “Add Rows” button is used 
to add additional parcels to the project.  To view this screen after other screens have been 
accessed, use the View Menu from any of the other screens or use the <ctrl> + L keys. 

If a project has only one alignment specified on the Parcel Generator Screen, then all identified 
parcels will be included in the final corridor, and the Alignments Screen is unnecessary and will 
not appear. 

The sum of the likelihoods associated with all alignments within one group must equal 1.0 
because there must be one (and only one) alignment from a group that is selected for the final 
approved corridor.  The “Check Likelihood” button on the screen will automatically adjust that 
likelihood associated with the final alignment of each group so that the total sums to 1.0. 

The data entered through the Alignments Screen are stored in the Access Database containing the 
project’s data within the “Alignments” Table.  Each row of the table represents one alignment.  
Once the number of alignments are given in the Parcel Generator Screen, no further alignments 
can be added.  The data fields for the alignments are as follows: 

1. Alignment Description (Num and ID).  The two fields represent descriptive data for the 
alignment.  The first field is automatic and cannot be modified.  (Only the first field 
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cannot be changed; all other fields on this screen are editable.)  The second field is 
available so that parcels can easily be identified.  

2. Start New Group.  Alignments form groups so that one and only one alignment within a 
group will be selected for a project.  Alignments associated with one group must be listed 
together and the first alignment the starts a new group is indicated with a check mark in 
this column. 

3. Likelihood of Inclusion.  The simulation model is designed to be run towards the end of 
the Feasibility Phase or the Plan Authority Phase of a project before it is known with 
certainty what the final approved corridor will be; thus, it is possible that an alignment 
(i.e., a set of parcels) identified during the feasibility phase as possibly being within the 
required corridor may not end up within the final corridor as approved during 
environmental clearance.  If it is known with certainty that an alignment will be included 
in the final approved corridor, then 1.0 should be entered for the “Likelihood of 
Inclusion”; otherwise, a value less than 1.0 should be entered.  If 0 is entered, then that 
alignment will never be included within the final corridor, which is equivalent to deleting 
that alignment (and any associated parcels) from the project.    

4. Permit Cost.  If there is a permit cost associated with an alignment, it is entered in the 
final column of data. 

 The Basic Data Screen 

The Basic Data Screen allows for input or modification of project-level data.  It also contains 
four menus:  the File Menu used to save data, the View Menu used to view and/or modify data, 
the Run Menu used to execute the simulation model, and the Help Menu for accessing the help 
system.  The list of shortcut keys can also be accessed from the Help Menu.  The two buttons on 
the screen are redundant and are placed on the screen for ease of use.  Clicking the Simulate 
Button is equivalent to using the Run Option (or the F5 key) and clicking the Quit Button is 
equivalent to using the Exit Option (or <ctrl>+X).  You can also quit the application by clicking 
the “x” in the upper right corner of the screen; however, using the close box on the screen will 
cause you to lose any unsaved data and no warning message is given asking if you want to save 
your data. 

The data entered through the Basic Data Screen are stored in the “TitlePage” Table of the Access 
database containing the project’s data.  The “TitlePage” Table also contains the date of the latest 
simulation run of the data and the CPU time required of the run.  Once the Run Menu is used, 
data can no longer be modified without clicking the Reset Data Button.  The Basic Data Screen 
provides data entries for six categories of required information: 

1. Project Description.  The project description and author entries are provided for your 
convenience so that it will be easy to identify a specific set of data when viewing the 
Access database created by the project.  (Note that the database associated with a project 
contains both input and output data.) 

2. Environmental Clearance.  The simulation model is designed to be run toward the end of 
the Feasibility Phase or toward the start of the Plan Authority Phase of a project with the 
purpose of estimating the eventual cost of ROW; therefore, a key component is the 
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estimate of the time at which the environmental clearance will occur.  (Time is measured 
in months and represents the duration from the availability of the design schematics to 
obtaining environmental clearance.)  There are three parameters that will be used in 
generating this time:  the minimum possible time, the most likely time, and the maximum 
possible time. 

3. ROW Release Date.  After the environmental clearance has been obtained, it is necessary 
to obtain the release to begin the ROW acquisition process.  The length of time required 
for this depends on the priority of the project as well as the paperwork processing time.  
Time is measure in months and again there are three parameters needed (minimum, most 
likely, and maximum) for describing the probability distribution for the duration of time 
from obtaining environmental clearance to obtaining the ROW Release.   In other words, 
the duration of time measured in months from the availability of the design schematics to 
permission to begin the acquisition is the sum of generated times based on the data 
entered that describe the probability laws governing the environmental clearance and the 
ROW release date. 

4. Number of Replications.  A simulation model is designed to be an experiment based on 
the probability laws entered into the model so it is necessary to make several replications 
of a model run.  The final analysis of output depends on a statistical sample, the size of 
which is equal to the parameter identified as the Number of Replications.  

5. Inflation Rate.  The total cost for ROW acquisition will be expressed in terms of current-
day dollars (i.e., the present value) based on the input value of the nominal annual 
inflation rate.  It will be assumed that the nominal rate is compounded daily.  (Note that 
the inflation rate is not the rate at which land appreciates which may be more than the 
general inflation rate.) 

6. Early or Late Finish Time.  It is possible that the acquisition of ROW takes longer than 
expected thus forcing a delay in the start of construction, or it is possible that the 
acquisition of ROW takes a shorter time than expected thus allowing an early start of 
construction.  To quantify the costs or benefits associated with the start of construction, 
there are three required parameters:  a target date (the number of months between the 
point in time that the design schematics or available to the start of the Construct 
Authority Phase), the penalty cost for each day late, and the cost savings for each day 
early.  The number of days late or early is determined by comparing the time of 
possession for the final parcel required to the target completion date.  Some studies have 
suggested that a cost savings of 25–30% per year of the total project cost is a reasonable 
value for finishing a project early. 

7. Factors Related to Land Value Appreciation.  The final three data types (namely, the 
additional property cost increase, the event causing the additional increase, and the offset) 
refer to cost increases in property values that are in addition to normal inflation (but not 
caused by additional improvements to the property).  Based on several interviews, it 
appears the most common reason attributed to the cost increase is due to land purchased 
by speculators.  It is not always clear when speculative activity begins and whether or not 
early acquisitions would cause the land value to increase; therefore, under the heading 
“Speculation begins” a choice must be made as to what causes the land value increase to 
begin.  For example, assume that for a particular project the analyst feels that speculation 
will likely begin 2 months after the ROW Release is obtained, then the option “ROW 
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Release Obtained” would be selected using the drop-down menu for “Speculation 
begins”, and “2 months” would be chosen using the drop-down menu for “Offset for 
Speculation.” 

 Data Input Screens 

There are four data input screens:  the Alignments Screen,  the Basic Data Screen, the Parcel 
Data Screen, and the Parcel Possession/Cost Data Screen, which allows for data changes.  The 
initial data values are stored in an Access database; therefore, data may be changed within the 
program through a data screen or it may be changed outside the program by accessing the 
database directly, although this can be risky. 

Data Screens 

TAMSIM uses data screens to display information and allow for the input and modification of 
data.  There are eight different screens associated with the program.  These are: 

1. The Start-up Screen is to begin a new project or to continue with a saved project.  To 
begin a new project, either use the menu or use the <ctrl>+N shortcut keys.  To open an 
existing project, either use the menu or use the <ctrl>+O shortcut keys. 

2. The Parcel Generator Screen appears whenever the user chooses to begin a new project.  
A few counties (namely, Dallas, Harris, and Tarrant) had a sufficiently large number of 
projects to allow reasonable statistics to be obtained; thus, a user may choose one of those 
counties or a category of counties.  Based on the input from this screen, a project with the 
specified number of parcels is established; however, data regarding the parcels may be 
modified on later data screens, including the number of parcels that may be purchased 
early.  

3. The Alignments Screen appears if there is more than one alignment under consideration 
and enables the user to provide the likelihoods of each alignment being included in the 
final approved corridor and allows permit costs to be entered if relevant. 

4. The Basic Data Screen allows for input verification or modification of project-level data.  

5. The Parcel Data Screen allows for input verification or modification of some of the parcel 
level data including data related to impacts of future improvements and early acquisition. 

6. The Parcel Possession/Cost Data Screen allows verification or modification of parcel 
possession time and cost data.  Possession time refers to the number of months from the 
ROW release to the actual possession of the parcel.  The cost refers to the final purchase 
price of the parcel including the cost of land, cost of improvements, cost of damages, and 
any court costs or outsourcing costs, if relevant.  It does not include the cost of any 
improvements that are projected to be made during Plan Authority or Develop Authority 
phases of the project.  The only data that can be changed on this screen are the mean 
values, standard deviation values, and multipliers.  The other values listed on the screen 
are for information purposes only.  Once the Parcel Possession Data Screen is accessed, 
some data can no longer be changed including parcel names, nor can parcels be added or 
deleted. 
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7. The Detailed Results Screen appears at the conclusion of the simulation run and contains 
the detailed output from each replication of the simulated project.  

8. The Summary Statistics Screen contains a statistical summary of the results from the 
simulated project. 

 In addition, two text files are also created to allow communication between TAMSIM and 
EROW (an optimization program).  The first file created is called Cost.out and contains the 
average value over all replications of the amount of purchase cost spent for early acquisitions.  
The second file created is called Save.out and contains the average amount of reduction in 
total ROW costs due to early acquisition; thus, a negative number in the Save.out file refers to 
an increase in average total cost.  Each run of TAMSIM will produce one number to each file as 
a separate row.  If no files with these names are in the folder containing TAMSIM.exe, they will 
be created.   

The Detailed Results Screen 

The Detailed Results Screen can be accessed only after the simulation has been executed.  
Accessing this screen is either through the View Menu or the use of the F6 key.  The Detailed 
Results Screen contains:  the File Menu used to save data, the View Menu used to view data, and 
the Help Menu for accessing the help system.  The button on the screen is redundant and is 
placed on the screen for ease of use.  Clicking the Quit Button is equivalent to using the Exit 
Option (or <ctrl> + X).  You can also quit the application by clicking the “x” in the upper right 
corner of the screen; however, using the close box on the screen will cause you to lose any 
unsaved data, and no warning message is given asking if you want to save your data.   

A simulation involves a random experiment with several replications, the number of replications 
being determined from the Basic Data Screen.  Each replication involves generating times 
according to various probability distributions as defined by the data input screens for the time of 
environmental clearance, the time of ROW release, and the times of possession for each parcel.  
Costs are also generated according to probability distributions for acquisition of each parcel.  
Each replication will produce different times and costs due to the random nature of a simulation.  
The specific times and costs generated by each replication can be viewed on the Detailed Results 
Screen using the drop down menu immediately below the title.  The drop down menu for the 
different replications also allows you to view the mean times averaged across all replications and 
the standard deviation of those times.  Other descriptive statistics can be viewed on the Summary 
Statistics Screen through the use of View Menu (or the F7 key).  Also, the summary of the costs 
and savings for early acquisition as needed by EROW (the optimizer used to determine the 
optimal early ROW budget) is contained in two text files and are not viewed on this screen. 

Each replication will have a cost savings or additional cost expense depending on whether or not 
the replication produced times that resulted in an early completion of the acquisition process or a 
late completion of the acquisition process.  This cost savings or cost increase is displayed in the 
bottom right-hand corner of the screen.  (The data for these costs were taken from the Basic Data 
Screen). 
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There are three types of data displayed in the grid for each parcel on the screen: 

1. Parcel Description (Num, Name).  The first two fields represent descriptive data for the 
task or parcel.  Asterisks before the name of a parcel indicate that the parcel was 
purchased through eminent domain for that replication.   The number in parentheses after 
the parcel’s name is the alignment that contains the parcel as specified on the Parcel Data 
Screen.  

2. Task Duration (Duration, End).  The first row in the grid always refers to the time for 
obtaining the environmental clearance, and the second row refers to the time for 
obtaining the release to begin the right-of-way acquisition process.  Each row after that 
until the final row refers to the task of obtaining possession of a specific parcel.  The 
value of the times is always measured in the number of months after the design 
schematics are available.  The value for the ending time in the final (or “Stop”) row of the 
grid is the maximum ending parcel possession time.  There are two ending times 
presented; these times refer to the time to purchase the property if no early acquisitions 
are made, and the second ending times are the values obtained by the simulation under 
the early acquisition scenario.   

3. Costs (Present Value Cost, Present Value Cost with Early Acquisition).  The final two 
columns refer to the predicted cost of the parcel with and without early acquisition.  Red 
numbers indicate which parcels (if any) were purchased early.  The value of the costs is 
always in terms of present value, i.e., costs in terms of dollars at time 0 (namely, when 
the design schematics become available).  The cost of improvements made on the parcel 
after time 0 is based on data entered on the Parcel Data Screen.  Cost is based on the 
probability that an improvement will actually occur as well as the timing and amount of 
improvement that occurred.  Since we assume that the parcel acquisition costs are always 
input in terms of present day dollars, normal inflation will not affect costs but any 
appreciation in property value that is above the inflation costs will cause an increase in 
present day dollar cost of the parcel depending on the time at which the appreciation 
starts as specified on the Basic Data Screen.   

In addition to the parcel related data, the cost increase due to late completion or a cost savings 
due to early completion is also given.  These costs are determined based on the cost data given 
on the Basic Data Screen.   

The “Reset Data” button allows a new simulation to be run with new data. 

The File Menu -- Data Screens 

The File Menu allows for saves and exits.   The “Save” option is enabled only if there are new 
data to be saved.  If you have entered new data but the “Save” option is not enabled, use the TAB 
key to insure that the data has been recorded. 

1. Save.  The “Save” Option is used if you want to save data from the various data screens.  
The “Save” Option overwrites the old data file, so if you want to save the old date, use 
the “Make Backup” Option before the “Save” Option.  If none of the screens contain new 
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data, the “Save” Option will not be enabled.  You can use the <ctrl> + S keys as a 
shortcut for the “Save” Option. 

2. Make Backup.  The “Make Backup” Option copies the original file into a second file.  
When using the “Make Backup” Option, a dialog box will appear that requires you to 
name the second file.  If data in the original file have been changed by a previous save 
operation, this option is not enabled (i.e., the “Make Backup” Option is only available if 
it is still possible to make a backup of the original data).  You can use the F12 key as a 
shortcut for the “Make Backup” Option. 

3. Exit.  The “Exit” Option quits the program.  If any data have been changed, you will be 
given the option of saving it.  You can use the <ctrl> + X key (or the Quit Button) as a 
shortcut for the “Exit” Option.  If you want to skip the dialog box reminding you about 
unsaved data, use the close box (the “x” in the upper right corner) for the screen. 

 The File Menu -- Startup Screen 

There are three main options available from the File Menu on the Startup Screen:  

1. New.  The “New” Option (or <ctrl>+N) is used when you want to simulate a project for 
which no data have yet been stored.  When this option is chosen, a Parcel Generator 
Screen appears in which you identify the number of parcels within the project and the 
county or category of county in which the project is being planned.  Parcels are then 
generated with parameters according to historical data.  After the parcels are generated, 
the Basic Data Screen appears if only one alignment is used.  If more than one alignment 
is under consideration, then the Alignments Screen appears.  After the Alignments Screen 
the Basic Data Screen appears when the “Continue” button is used.  Parcel specific data 
can be changed by accessing the Parcel Data Screen through the View Menu on the Basic 
Data Screen.   

2. Open.  The “Open” Option (or <ctrl>+O) is used if you want to simulate a project for 
which you have already saved some data.  After identifying the data file containing the 
data, the Basic Data Screen.  You can then modify any of the previously stored data 
before executing the simulation. 

3. Exit.  The “Exit” Option (or <ctrl>+X) is used to quit this application.  The “Cancel” 
button is the same as the Exit Option.   

 Getting Started 

TAMSIM is a simulation program that can be used to estimate the cost of ROW acquisition for a 
specified project.  All data needed for running the simulation are stored in an Access Database.  
All data, both input and output, are displayed on various Data Screens within TAMSIM.  The 
data can be entered into the database and later modified using TAMSIM.  The minimum 
requirements to run the simulation is the Microsoft .NET Framework 2.0, and a folder containing 
three files:  TAMSIM.exe (the compiled version of the simulation program), _db.tmp (a 
hidden file that is the database containing all parameters of the code), and tamsim.chm (the 
compiled HTML help file).  Note that it is important for these three files to be in the same 
folder.   The program works with both Windows XP and Vista; however, it does not work using 
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a 64-bit operating system.  When in doubt, the F1 key can be used to access the Help System, 
which also includes a list of shortcut keys for the various menu options. 

To run TAMSIM, there are five types of data needed: 

1. Project level data entered on the Basic Data Screen. 

2. Alignment level data entered on the Alignment Screen. 

3. Parcel level data entered on the Parcel Data Screen. 

4. Possession time data (referring to the time span beginning with ROW release and ending 
with the obtaining possession of the parcel) entered on the Parcel Possession/Cost Data 
Screen. 

5. Cost data, which is the total purchase price of a parcel including the value of the land, 
improvements, and damages, also entered on the Parcel Possession/Cost Data Screen. 

The steps needed for using this simulation program are as follows: 

1. Create or identify the database file containing the data for this run using one of the 
options under the File Menu (or use <ctrl>+N, or <ctrl>+O keys) of the Start-up 
Screen. 

a. Choose the “New” option on the File Menu (or <ctrl>+N) to create a new project 
for which parcel data will be automatically generated. (Modification of the 
automatically generated data is possible later through the various data input 
screens.  All data input screens can be accessed through the View Menu that is on 
all data screens.)  When the “New” option (<ctrl>+N) is chosen, the Parcel 
Generator Screen will appear.  The number of parcels of land needed to satisfy the 
ROW requirements for the project is entered on this screen.  If only one alignment 
is to be used for the project, the next screen to appear will be the Basic Data 
Screen; otherwise, the Alignments Screen will appear next.  After the Alignments 
Screen, the next screen to appear will be the Basic Data Screen.  

b. Choose the “Open” option on the File Menu (or <ctrl>+O) to open an existing 
project.  You can verify the parcel data after the Basic Data Screen appears. 

 Enter, verify, or modify the project level data on the Basic Data Screen.  Project level 
data refer to those data that are not associated with individual parcels. 

 Verify  and/or modify the parcel level data using the Parcel Data Screen that is displayed 
through an option on the View Menu or by the F3 key. 

 Verify and/or modify the possession time (i.e., the time from ROW release to parcel 
possession) and cost data using the Parcel Possession/Cost Data Screen that is displayed through 
an option on the View Menu or by the F4 key.  Once the Parcel Possession Data Screen has been 
accessed, parcels can no longer be added or deleted. 

 Save data that have been modified by choosing an option on the File Menu.  Because the 
save operation overwrites the old data, you may want to make a backup of the original data again 
through the use of the File Menu or by using the F12 key.  Once the Save Option has been used, 
a backup is no longer possible since the original data are no longer available.  
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 Choose the “Run Simulation” option on the Run Menu (or the F5 key) to execute the 
simulation.  After the simulation is complete, the Summary Statistics Screen will be displayed. 

 After the run, there are two output screens.  Data for each replication of the simulation is 
contained in the Detailed Results Screen, and a summary of the results is contained in the 
Summary Statistics Screen.  Again, you may choose to save the output or not save it. 

 Two text files are also created to allow communication between TAMSIM and EROW 
(an optimization program).  The first file created is called Cost.out and contains the average 
value over all replications of the amount of purchase cost spent for early acquisitions.  The 
second file created is call Save.out and contains the average amount of reduction in total 
ROW costs due to early acquisition; thus, a negative number in the Save.out file refers to an 
increase in average total cost.  Each run of TAMSIM will produce one number to each file as a 
separate row.  If no files with these names are in the folder containing TAMSIM.exe, they will 
be created.   

The Parcel Data Screen 

The Parcel Data Screen allows for input or modification of parcel specific data.  It also contains 
four menus:  the File Menu used to save data, the View Menu used to view and/or modify data, 
the Run Menu used to execute the simulation model, and the Help Menu for accessing the help 
system.  The list of shortcut keys can also be accessed from the Help Menu.  Two of the three 
buttons on the screen are redundant and are placed on the screen for ease of use.  Clicking the 
Simulate Button is equivalent to using the Run Option (or the F5 key) and clicking the Quit 
Button is equivalent to using the Exit Option (or <ctrl>+X).  You can also quit the application 
by clicking the “x” in the upper right corner of the screen; however, using the close box on the 
screen will cause you to lose any unsaved data and no warning message is given asking if you 
want to save your data.  The “Add Rows” button is used to add additional parcels to the project.  
To view this screen, use the View Menu from any of the other screens or use the F3 key. 

The data entered through the Parcel Data Screen are stored in the Access Database containing the 
project’s data within the “ParcelList” Table.  Each row of the table represents one parcel and 
during the editing phase, it is possible to add rows as well as change individual data items within 
a row.  A parcel is added using the “Add Rows” button, and a parcel is effectively deleted by 
entering zero in the third column (namely, set the “Likelihood of Inclusion” to zero for the parcel 
to be deleted).  Once the Run Menu is used, data can no longer be modified without resetting the 
simulation.  The data fields for the parcels are as follows: 

1. Parcel Description (Num and ID).  The two fields represent descriptive data for the 
parcel.  The first field is automatic and cannot be modified.  (Only the first field cannot 
be changed; all other fields on this screen are editable.)  The second field is available so 
that parcels can easily be identified.  

2. Associated Alignment.  The simulation model is designed to be run toward the end of the 
Feasibility Phase or the Plan Authority Phase of a project before it is known with 
certainty what the final approved corridor will be; thus, it is possible that parcels 
identified during the feasibility phase as possibly being within the required corridor may 
not end up within the final corridor as approved during environmental clearance.  Parcels 
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that are accepted or rejected as a unit are associated with an alignment and such an 
alignment is identified in the third column.  The probability that an alignment will be 
included in the final approval is given on the Alignments Screen.  If all parcels identified 
in the project are to be included in the final corridor, then only one alignment will be used 
and the Alignment Screen never appears; in this case, all parcels should be associated 
with alignment #1.  

3. Likelihood of Outsourcing.  Some districts use outside contractors for the accessing and 
acquiring of parcels.  The data related to possession time differs depending on whether 
the parcel is being processed through an outside contractor or by district employees.  If it 
is known with certainty that a parcel will be acquired through an outside contractor, then 
1.0 should be entered here; if it is know for certain that district employees will be used to 
access and acquire the parcel, then 0.0 should be entered. Otherwise, a value between 0.0 
and 1.0 should be entered. 

4. Likelihood of Condemnation.  The likelihood that condemnation proceedings will be 
necessary to acquire the parcel should be entered.  This field requires a value less than or 
equal to 1.0 and greater than or equal to 0.0.  Both the time to acquire the parcel and the 
final cost required to purchase the parcel are affected if condemnation proceedings are 
necessary. 

5. Likelihood of Improvements.   The usual reason that early acquisition is economically 
beneficial is the likelihood that improvements will be made on the parcel under 
consideration.  This input requires a number between zero and one (inclusive) 
representing the probability that improvements will be made.  If no improvements are 
expected, this probability would be set to zero and early acquisition would be unlikely.  
When this entry is zero, the remaining entries for that parcel are ignored.  However, if 
improvements are a possibility, then a positive value would be entered here and it is 
important to fill in the remaining data entries.  

6. Time Duration over which Improvement Will Likely Occur.  The next four entries refer to 
establishing a probability law that will reflect the timing over which the improvements 
will be made.   

7. Cost multiplier for Improvements.  During the simulation, a random value based on a 
probability law defined through the next screen will be generated that will represent the 
cost of each parcel.  If improvements are made on the parcel, then this random value will 
be multiplied by the value (any number greater than one) entered here to determine the 
total cost of the parcel. 

8. Indicator for Early Acquisition.  If there is a check mark under this entry, then the parcel 
will be acquired early.  During the simulation, total project ROW costs and the time at 
which all parcels are purchased will be computed without any early acquisition and with 
early acquisition of those parcels that have been checked. 

 The Parcel Generator Screen 

The Parcel Generator Screen is the first screen to appear whenever the “New” Option is used 
from the File Menu on the Startup Screen.  This screen is used so that you can indicate how 
many parcels are to be included in project, how many parcels are expected to have future 
improvements, how many of those parcels will be purchased early, and how many alignments 
will be used in the project.  (Future improvements refer to the possibility of improvements on the 
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parcel after the schematic diagrams have been developed.  This is important because, in general, 
these are the parcels for which early acquisition would likely prove beneficial.)  The screen also 
indicates the data set to be used; that is, if a specific county, class of counties, are state-wide 
values are to be used.  

The data for a Metropolitan area were obtained by averaging over all counties with population 
size large than 400,000.  The Urban Area is for counties with a population between 50,000 and 
400,000, and the Rural Area is those counties less than 50,000.  

After entering the requested data on this screen, click on the “Continue” button or use the F5 
key.  If only one alignment is entered for the project, the next screen to appear after the 
continuing is the Basic Data Screen.  If more than one alignment is entered on this screen, then 
the Alignments Screen will be the next screen to appear.  After continuing, you may correct any 
of the numbers entered by adding or deleting individual parcels through the Parcel Data Screen.  
However, if you want to change either the selection of the county or the data set used to generate 
the data (i.e., the choice of metropolitan, urban, or rural) or the number of alignments used for 
the project, it will be necessary to start over.  

The Parcel Possession/Cost Data Screen 

The Parcel Possession Data Screen displays possession time and possession cost distributional 
data for each parcel.  Possession time refers to the number of months from the ROW release to 
the actual possession of the parcel.  The cost refers to the final purchase price of the parcel 
including the cost of land, cost of improvements, cost of damages, and any court costs or 
outsourcing costs, if relevant.  It does not include the cost of any improvements that are 
projected to be made during Plan Authority or Develop Authority phases of the project.  If 
improvements are made on the parcel during the Plan Authority or Develop Authority phases, 
these will be according to the probability laws specified on the Parcel Data Screen. The only data 
that can be changed on this screen are the mean values, standard deviation values, and 
multipliers.  The other values listed on the screen are for information purposes only.  Once the 
Parcel Possession/Cost Data Screen is accessed, the parcel name cannot be changed nor can 
parcels be added or deleted. 

The Parcel Possession Data Screen contains four menus:  the File Menu used to save data, the 
View Menu used to view and/or modify data, the Run Menu used to execute the simulation 
model, and the Help Menu for accessing the help system.  The “Simulate” and “Quit” buttons on 
the screen are redundant and are placed on the screen for ease of use.  Clicking the Simulate 
Button is equivalent to using the Run Option (or the F5 key) and clicking the Quit Button is 
equivalent to using the Exit Option (or ctrl-X).  You can also quit the application by clicking the 
“x” in the upper right corner of the screen; however, using the close box on the screen will cause 
you to lose any unsaved data, and no warning message is given asking if you want to save your 
data.  Once the simulation has been executed, input data may no longer be changed. 

Within a single project, parcels are not independent of each other.  That is, if one parcel tends to 
be relatively expensive, other parcels will more likely be expensive as well.  The probability law 
governing both duration and costs is a lognormal distribution, which is a distribution that is 
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skewed to the right.  For these distributions, the mean and standard deviation can be modified, 
which will automatically change the minimum, median, and maximum values.  The minimum, 
median, and maximum values are displayed so that a better intuitive understanding of the 
distribution can be obtained.  The displayed values for the mean and variance indicate the project 
mean and variance.  The individual parcels are then generated around the lognormally generated 
project mean.  However, if the user changes a specific mean and variance, those numbers will 
refer to the specific parcel and that parcel’s data will be generated independently according to the 
new values.  

Note:  The first row (numbered zero) of data on this screen refers to the project values that are 
averaged over all parcels in the project and does not refer to any one specific parcel.  Changing a 
value in this first row will change the values of all parcels. 

The Run Menu – Input Data Screens 

The Run Menu is used to execute the program.  The “Run Simulation” Option causes an 
execution of the model by simulating the project a number of time according to the “Number of 
Replications” parameter specified on the Basic Data Screen.  The next screen to appear will be 
the Summary Statistics Screen.  You can use the F5 key as a shortcut. 

The Run Menu – Parcel Possession Screen 

The Run Menu has only one option, the “Run Simulation” option, and it is used to finish the 
execution of the program, namely, it will run the simulation portion of the program.  You can use 
the F5 key as a shortcut. 

Shortcut Keys 

 Key Function 

<ctrl> + L View and/or modify data on the Alignments Screen 

<ctrl> + N 
Create a new project.  Only available from the File Menu of the Input 
Screen 

<ctrl> + O 
Open an existing project data file.  Only available from the File Menu of 
the Input Screen 

<ctrl> + S Save data from the various screens 

<ctrl> + X Exit the program 

F1 View help 

F2 View and/or modify data on the Basic Data Screen 

F3 View and/or modify data on the Parcel Data Screen 

F4 View and/or modify data on the Parcel Possession Data Screen 

F5 
Run simulation if used on a Data Entry Screen, or continue with data 
entry if used on the Parcel Generator Screen 

F6 View the Detailed Output Data Screen 

Submittal



 

105 
 

F7 View output on the Summary Statistics Data Screen. 

F12 Copy existing data file to a backup data file 

The Summary Statistics Screen 

The Summary Statistics Screen will automatically display at the conclusion of a simulation run.  
This screen contains three menus:  the File Menu used to save data, the View Menu used to view 
data, and the Help Menu for accessing the help system.  The button on the screen is redundant 
and is placed on the screen for ease of use.  Clicking the Quit Button is equivalent to using the 
Exit Option (or <ctrl> + X).  You can also quit the application by clicking the “x” in the upper 
right corner of the screen; however, using the close box on the screen will cause you to lose any 
unsaved data, and no warning message is given asking if you want to save your data.  

The summary of the costs and savings for early acquisition as needed by EROW (the optimizer 
used to determine the optimal early ROW budget) is contained in two text files and are not 
viewed on this screen. 

A simulation involves a random experiment with several replications, the number of replications 
being determined from the Basic Data Screen.  Each replication involves generating times 
according to various probability distributions as defined by the data input screens for the time of 
environmental clearance, the time of ROW release, and the times of possession for each parcel.  
Costs are also generated according to probability distributions for acquisition of each parcel.  
Each replication will produce different times and costs due to the random nature of a simulation.  
The specific times and costs generated by each replication can be viewed on the Detailed Results 
Screen (which can be viewed using the F6 key) and a statistical summary of the results is viewed 
on this screen (the Summary Statistics Screen). 

The summary includes mean values, standard deviation, and the 10, 50, and 90 percentile values.  
If the cost differences shown under the “Impact of Early Acquisition” portion of the screen are 
negative, then early acquisition reduces costs.   

There are two types of data displayed in the grid on the screen: 

1. Project Duration.  Time is the number of months from the availability of the design 
schematics to the time at which possession has been achieved for all parcels.  The 
estimates for the mean and standard deviation also include 95% confidence intervals 
based on the t-statistic for the means and the chi-squared statistic for the standard 
deviations.  The statistics are based on a sample size equal to the number of replications 
as given in the Basic Data Screen. 

2. Costs.  The cost values are in terms of “present day” dollars, where the present day refers 
to the point in time at which the design schematics first become available.  The cost for 
the project is the sum of the personnel costs for the possession tasks, the right-of-way 
acquisition costs including improvements (if any), and the cost savings or cost increase 
obtained by comparing the final parcel possession time to the target date as given on the 
Basic Data Screen.   
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The “Reset Data” button allows a new simulation to be run with new data. 

 Text File Output 

Output from TAMSIM is used as input data to EROW, an optimizer used for determining the 
budget in the early acquisition of right of way.  Specifically, EROW needs from TAMSIM 
estimates for the total dollar value for early acquisition purchases and the resultant savings in 
total cost.  In order to facilitate the easy transfer of information from TAMSIM to EROW, two 
text files are created containing this information.   

After execution of the simulation, a text file named Cost.out will contain the average value 
for the total costs of all parcels purchased early, and a text file named Save.out will contain 
the average value of the total savings in cost due to the early acquisition.  (Note that a positive 
value in the Save.out file implies a reduction in total costs, and a negative value implies and 
increase in total cost due to early acquisition.)  The following are some properties associated 
with these files: 

1. The files will be located in the same folder that contains TAMSIM.exe.  
2. If the files do not exist, they will be created.  
3. If the files already exist, the data from the simulation run will be appended to the already 

existing data.  
4. Each run of TAMSIM will produce one number for each file.  

The View Menu – Input Data Screens 

The View Menu is used to switch among the various data screens to verify and possibly modify 
your data.     

1. Alignment Data.  The “Alignment Data” Option (not visible from the Alignment Screen) 
is used to bring forward the Alignment Screen.  The Alignment Screen can be used to 
change alignment level data; however, alignments cannot be added.  (Alignments can be 
deleted by setting their likelihood of inclusion equal to zero.)  You can use the <ctrl> + L 
keys as a shortcut. 

2. Basic Data.  The “Basic Project Level Data” Option is used to bring forward the Basic 
Data Screen.  The Basic Data Screen displays project level data, which are data not 
related to specific parcels.  You can use the F2 key as a shortcut. 

3. Parcel Data.  The “Parcel Related Data” Option is used to bring forward the Parcel Data 
Screen.  The Parcel Data Screen displays parcel specific data.  You can use the F3 key as 
a shortcut. 

4. Possession Time/Cost Data.  The “Possession Time/Cost Data” Option is used to bring 
forward the Parcel Possession/Cost Data Screen.  This screen displays possession time 
and possession cost distributional data for each parcel.  Possession time refers to the 
number of months from the ROW release to the actual possession of the parcel.  The cost 
refers to the final purchase price of the parcel including the cost of land, cost of 
improvements, cost of damages, and any court costs or outsourcing costs, if relevant.  It 
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does not include the cost of any improvements that are projected to be made during Plan 
Authority or Develop Authority phases of the project.  The only data that can be changed 
on this screen are the mean values, standard deviation values, and multipliers.  The other 
values listed on the screen are for information purposes only.  Once the Parcel Possession 
Data Screen is accessed, the parcel name cannot be changed nor can parcels be added or 
deleted.  You can use the F4 key as a shortcut. 

5. Detailed Results.  The “Detailed Output Data” Option is used to bring forward the 
Detailed Results Screen.  The purpose of TAMSIM is to simulate several replications of 
the right-of-way acquisition process.  Each replication involves generating times, costs, 
and possession method according to the probability distributions given by the input data.  
The results of each replication are displayed on the Detailed Results Screen.  (The 
various replications are viewed by use of the drop down menu located just under the 
heading.)  You can use the F6 key as a shortcut. 

6. Summarized Results.  The “Summarized Output Data” Option is used to bring forward 
the Summary Statistics Screen.  The results from the simulation run are summarized in 
the Summary Statistics Screen.  You can use the F7 key as a shortcut. 

The View Menu – Output Data Screens 

The View Menu is used to switch among the various data screens to verify your data.  (Since the 
simulation has already been run, no input data can be modified.)  Thus, the purpose of this menu 
is to allow you to review and/or confirm the data used as input to the project. 

1. Alignment Data.  The “Alignment Data” Option (not visible from the Alignment Screen) 
is used to bring forward the Alignment Screen.  The Alignment Screen can be used to 
change alignment level data; however, alignments cannot be added.  (Alignments can be 
deleted by setting their likelihood of inclusion equal to zero.)  You can use the <ctrl> + L 
keys as a shortcut. 

2. Basic Data.  The “Basic Project Level Data” Option is used to bring forward the Basic 
Data Screen.  The Basic Data Screen displays project level data, which are data not 
related to specific parcels.  You can use the F2 keys as a shortcut. 

3. Parcel Data.  The “Parcel Related Data” Option is used to bring forward the Parcel Data 
Screen.  The Parcel Data Screen displays parcel specific data.  You can use the F3 key as 
a shortcut. 

4. Parcel Possession Data.  The “Parcel Possession Data” Option is used to bring forward 
the Parcel Possession Data Screen for each individual parcel.  You can use the F4 key as 
a shortcut. 

5. Detailed Results.  The “Detailed Output Data” Option is used to bring forward the 
Detailed Results Screen.  The purpose of TAMSIM is to simulate several replications of 
the right-of-way acquisition process.  Each replication involves generating times, costs, 
and possession method according to the probability distributions given by the input data.  
The results of each replication are displayed on the Detailed Results Screen.  (The 
various replications are viewed by use of the drop down menu located just under the 
heading.)  You can use the F6 key as a shortcut. 
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6. Summarized Results.  The “Summarized Output Data” Option is used to bring forward 
the Summary Statistics Screen.  The results from the simulation run are summarized in 
the Summary Statistics Screen.  You can use the F7 key as a shortcut. 

The View Menu – Possession Times Data 

The View Menu is used to switch among the various data screens to verify your data.  Once the 
Parcel Possession/Cost Data Screen has been accessed, it is not longer possible to add or delete 
parcels.  Thus returning to the Parcel Data Screen allows the user to view or modify all data 
except for the name; however, some of the data on the Basic Data Screen cannot be modified 
after accessing the Parcel Possession/Cost Data Screen. 

1. Alignment Data.  The “Alignment Data” Option (not visible from the Alignment Screen) 
is used to bring forward the Alignment Screen.  The Alignment Screen can be used to 
change alignment level data; however, alignments cannot be added.  (Alignments can be 
deleted by setting their likelihood of inclusion equal to zero.)  You can use the <ctrl> + L 
keys as a shortcut. 

2. Basic Data.  The “Basic Project Level Data” Option is used to bring forward the Basic 
Data Screen.  The Basic Data Screen displays project level data, which are data not 
related to specific parcels.  You can use the <ctrl> + B keys as a shortcut. 

3. Parcel Data.  The “Parcel Related Data” Option is used to bring forward the Parcel Data 
Screen.  The Parcel Data Screen displays parcel specific data.  You can use the F2 key as 
a shortcut. 

4. Detailed Results.  The “Detailed Output Data” Option is used to bring forward the 
Detailed Results Screen.  The purpose of TAMSIM is to simulate several replications of 
the right-of-way acquisition process.  Each replication involves generating times, costs, 
and possession method according to the probability distributions given by the input data.  
The results of each replication are displayed on the Detailed Results Screen.  (The 
various replications are viewed by use of the drop down menu located just under the 
heading.)  You can use the F6 key as a shortcut. 

5. Summarized Results.  The “Summarized Output Data” Option is used to bring forward 
the Summary Statistics Screen.  The results from the simulation run are summarized in 
the Summary Statistics Screen.  You can use the F7 key as a shortcut. 
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APPENDIX C – EROW HELP INFORMATION 

 

EARLY RIGHT OF WAY (EROW) BUDGET OPTIMIZATION TOOL 
 
This optimization tool solves for optimal budget allocation among a set of projects for which each is 
considered under a series of early acquisition scenarios (versions) for a range of possible early acquisition 
total budgets. The application requires the input from two text files created by TAMSIM, one containing 
all associated cost data and the other containing all associated savings data for the set of projects being 
considered. The results provided by EROW give guidance for selecting a budget allocation for early right-
of-way acquisition. 
 

PROJECT INPUT TAB 
 
• Budget Data 
 
Enter values to define the range for the allowable early acquisition budget solution: the minimum 
allowable early acquisition budget, the maximum allowable early acquisition budget, and the increment 
size to be considered between these limits.  Currently, the program will handle up to 10,000 increments. 
Guidance is provided for the user below the increment data entry field to assist in selecting an increment 
meeting this limitation. 
 
• Results Options 
 
The results options box contains two checkboxes for selecting information to be displayed under the 
results tab.  
 
If the first box is checked, the results to be displayed will include the selected version for each project in 
addition to the savings to be obtained from each early acquisition budget level being considered.  
 
If the second box is checked, EROW will estimate the rate of return to be realized from each increase in 
budget from the prior budget option analyzed. The rate of return realized from this additional budget 
amount is then compared to the minimal attractive rate of return (MARR) specified by the user. When the 
rate of return realized from the amount of budget increase does not exceed the MARR, this incremental 
budget is eliminated as a possible total budget solution.  
 

• Cost Data 
 
The user can browse files to select a text file containing cost data. The rows in the text file correspond to 
different scenarios for each project. This text file is normally created by TAMSIM and saved for use in an 
EROW budget analysis. 
 
• Savings Data 
 
The user can browse files to select a text file containing savings data. The rows in the text file correspond 
to different scenarios for each project. This text file is normally created by TAMSIM and saved for use in 
an EROW budget analysis. 
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EXAMPLE INPUT DATA FORMATS 
 
Maximum Budget: 100000 
 
Minimum Budget: 10000 
 
Increments: 1000 
 

If nine early acquisition versions for project 1, six early acquisition versions for project 2, and 11 early 
acquisition versions for project 3 are considered, the input data will be in the format shown below.  The 
first column of zeros reflects costs and savings involved if a project is not selected for a given solution. 
 
Costs: 
 
  0      12115       17061        20604        20989        22078        22861        23241        24067 
  0      12856       21831        26125        27195        28204 
  0        2145         4075          5390          5508          5599           5705          5800          5901        6027        6160 
 

Savings: 
 
  0        6536        9830        12966        13894        15862        18708        20040        23603 
  0        5189        8579        11073        13957        16561         
  0        1191        2285          3230          3804          4293          4844           5305         5788          6291        6885 
 
 

RESULTS TAB 
 
The results tab displays the total savings estimated from optimal use of each early acquisition budget 
being considered, starting with the minimum allowable budget solution and continuing in increments up 
to the maximum allowable budget solution.  
 
If the first box is checked in the results options box, the results to be displayed for each total early 
acquisition budget being considered includes the selected version for each project that will result in the 
displayed optimal savings.  
 
If the second box is checked in the results options box, the results being displayed only include early 
acquisition budgets for which the incremental budget increase met the specified MARR criteria.  
 
A Summary box at the bottom of the results screen displays two of the numerous possible early 
acquisition budget solutions, the first being the budget solution providing the highest rate of return and 
the second being the budget solution providing the maximum amount of savings achievable consistent 
with the budget limitations and the MARR if one is specified by the user.  
 
The computational results can be plotted by clicking on the “Plot Results” button. Peaks in the rate of 
return plot indicate more favorable early acquisition budget options. The computational results can be 
saved in a simple tabular format by clicking on the “Save Results” button. 
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